Notation Player 3 User
Guide

Notation Player 3 User Guide
© 2020 Notation Software, Inc.
All rights reserved. Parts or the whole of this work may be reproduced only for personal use. Parts or the whole of this work
may not be reproduced and distributed more than 10 times by any individual, company, or institution, in any form or by any
means - graphic, electronic, or mechanical, including photocopying, recording, taping, or information storage and retrieval
systems - without the written permission of the publisher.
Products that are referred to in this document may be either trademarks and/or registered trademarks of the respective
owners. The publisher and the author make no claim to these trademarks.

Contents

3

Table of Contents
Foreword

0

Part I Introduction

5

1 Getting...................................................................................................................................
Started
5
Using This Docum
..........................................................................................................................................................
entation
5
Printing This Docum
..........................................................................................................................................................
entation
6
Installing Notation
..........................................................................................................................................................
Player
6
Finding and Starting
..........................................................................................................................................................
Notation Player on Your System
7
Setting up Your..........................................................................................................................................................
Default MIDI Playback Device
7
Uninstalling Notation
..........................................................................................................................................................
Player
8

2 Quick Start
...................................................................................................................................
Tutorial
9
Tutorial: Opening
..........................................................................................................................................................
a Song File on Your System
9
Tutorial: Playing
..........................................................................................................................................................
the Song
11

Part II Opening and Transcribing Songs

14

1 Opening
...................................................................................................................................
a Song File on Your System
14
2 Viewing
...................................................................................................................................
the Song Title and Author Information
14
3 Searching for and Downloading MIDI and NoteSoft Files from the
................................................................................................................................... 15
Internet
Using Notation..........................................................................................................................................................
Player's Internet Brow sing Window
15
Specifying the..........................................................................................................................................................
Initial Web Page for Brow sing
17
Dow nloading MIDI
..........................................................................................................................................................
Files and Zip Files
17
Associating Notation
..........................................................................................................................................................
Player w ith .MID, .KAR, and .NOT Files
19

4 Transcribing
...................................................................................................................................
MIDI Files to Notation
21
Transcription..........................................................................................................................................................
Options
23
Re-Transcribing
..........................................................................................................................................................
a MIDI File
25

Part III Navigating through Notation Player and the
Score

27

1 Parts ...................................................................................................................................
of the Notation Window
28
Show ing and Hiding
..........................................................................................................................................................
Parts of the Window
28
Menus
.......................................................................................................................................................... 29
Toolbar
.......................................................................................................................................................... 30
Play Buttons
......................................................................................................................................................... 30
Volume Control
......................................................................................................................................................... 31
Zoom-In and
.........................................................................................................................................................
Zoom-Out Buttons
31

2 Window
...................................................................................................................................
View and Page View
31
3 Viewing
...................................................................................................................................
Multiple Song Files at a Time
32
4 Scrolling,
...................................................................................................................................
Resizing and Zooming the Window
32
Scrolling the Window
.......................................................................................................................................................... 33
Resizing the Window
.......................................................................................................................................................... 33
Zoom ing the Window
.......................................................................................................................................................... 34

5 Navigating
...................................................................................................................................
through Pages of the Score
34
First Page, Next
..........................................................................................................................................................
Page, Previous Page, and Last Page
35
Go to a Measure
..........................................................................................................................................................
or Page
35
Go to a Rehearsal
..........................................................................................................................................................
Mark
36

3

4

Notation Player 3 User Guide

Part IV Playing Songs

37

1 Quick...................................................................................................................................
MIDI Device Setup
37
2 Starting
...................................................................................................................................
and Stopping Playback
38
3 Fast Forwarding
................................................................................................................................... 39
4 Changing
...................................................................................................................................
the Song Position During Playback
39
5 Turning
...................................................................................................................................
Off Stuck Notes
39
6 Controlling
...................................................................................................................................
the Overall Volume Level
39
7 Ignoring
...................................................................................................................................
Repeats and Endings
40
8 What ...................................................................................................................................
To Do If You Do Not Hear Any Sound
40
9 Reassigning
...................................................................................................................................
MIDI Devices
44

Part V Formatting the Score

46

1 Selecting
...................................................................................................................................
a Part
46
2 Showing
...................................................................................................................................
or Hiding Instrument Names
46
3 Hiding
...................................................................................................................................
Empty Staves
47
4 Measure
...................................................................................................................................
Numbers
47

Part VI Editing and Saving Songs

49

1 Adding
...................................................................................................................................
Key Signatures
49
2 Adding
...................................................................................................................................
Clefs
51
3 Collapsing
...................................................................................................................................
Multiple Measure Rests
51
4 Multiple
...................................................................................................................................
Level Undo
52

Part VII About Notation Musician and Composer

54

1 About...................................................................................................................................
Notation Musician
55
2 About...................................................................................................................................
Notation Composer
57
3 Comparison
...................................................................................................................................
of Notation Products
60

Part VIII Appendixes

66

1 Appendix
...................................................................................................................................
A: What is MIDI?
66
2 Appendix
...................................................................................................................................
B: Technical Support
67
3 Appendix
...................................................................................................................................
C: Notation Player License Agreement
67
4 Appendix
...................................................................................................................................
D: Licensing and Acknowledgements
69

Index

72

Introduction

1

5

Introduction
Welcome to Notation Software's free N o ta tio n P la y e r!
Almost any musician who reads music notation will be amazed at the simplicity, elegance, and
usefulness of this convenient music software utility. With N o ta tio n P la y e r, you can
see
the notation
of the music as you
hear
it.
N o ta tio n P la y e r serves two main purposes:
1.

To transcribe any MIDI (.mid) or Karaoke (.kar) file to sheet music that you can view on the
screen as the notes play.

2.

To play and display fully notated and annotated music notation Notation (.not) files, that have
been prepared by other programs by Notation Software: N o ta tio n Mus ic ia n and N o ta tio n
Co mp o s e r.

N o ta tio n P la y e r offers the same high-quality MIDI-to-notation transcription as do N o ta tio n
Mus ic ia n and Co mp o s e r. The MIDI-to-transcription technology was first developed in 1994 and
1995, and has continued its reputation since then as the world's best. N o ta tio n P la y e r offers you that
MIDI-to-transcription feature completely free!
We hope that N o ta tio n P la y e r will open the doors for you to see how entertaining and educational it
is to hear the music and see the notation at the same time. If that happens, we encourage you to
explore free 30-day versions of the N o ta tio n software products. For more information, see the topic
About Notation Musician and Composer or visit our website to find out more about N o ta tio n
Mus ic ia n and N o ta tio n Co mp o s e r and see video demonstrations of them in action..
You probably will be able to learn how to use most of N o ta tio n P la y e r's features by simply trying out
menu commands and clicking buttons here and there. However, for a quick start in learning how to use
N o ta tio n P la y e r, we recommend going through the Quick Start Tutorial. We hope you will enjoy
using N o ta tio n P la y e r!

1.1

Getting Started
If you have already successfully installed N o ta tio n P la y e r, and are already comfortable using this
documentation, then you might want to skip this Getting Started section.
This Getting Started section offers the following introductions and instructions:
Using this Documentation
Printing this Documentation
Installing N o ta tio n P la y e r
Finding and Starting Notation Player
Setting up Your MIDI Playback Device
Uninstalling N o ta tio n P la y e r

1.1.1

Using This Documentation
This N o ta tio n P la y e r documentation is organized according to tasks that you can accomplish and
will want to learn about.
T o find the d o c ume nta tio n tha t e xp la ins ho w to a c c o mp lis h a c e rta in ta s k :
If you are viewing this documentation on the screen, then do one of the following:
Navigate through the T a b le Co nte nts , at the left side of this Help window, until you find the
category and sub-category of documentation that is relevant to your need.
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-- OR -Click on the S e a rc h or (BEST) Ind e x tab at the left side of this Help window. If you are
interested, for example, in help topics that specifically focus on setting up this program, then
look up "setup" in the Index, or use "setup" as the keyword for Search.
Although the N o ta tio n P la y e r documentation is particularly well-organized to answer "how to"
questions, it also provides quick reference information, if you already know, for example, what menu
command or dialog box you should be using, but just need some help on how to use the command or
dialog box.
T o le a rn a b o ut the p urp o s e a nd us e o f a p a rtic ula r me nu ite m:
While holding the mouse over the menu item, hit the F1 key. N o ta tio n P la y e r will display this
help window, presenting the topic that describes the situations in which you might want to use
that menu command, and the overall procedures in which you would use that command.
T o le a rn a b o ut the p urp o s e a nd us e o f a b utto n o r c o ntro l in the ma in to o lb a r:
While holding the mouse over the button or control, hit the F1 key.
T o le a rn a b o ut the d e ta ils o f a d ia lo g b o x:
Click the Help button in the dialog box.

1.1.2

Printing This Documentation
For printing out any part of this documentation we strongly recommend getting the PDF version.
T o g e t the N o ta tio n P la y e r d o c ume nta tio n in A d o b e A c ro b a t P D F file fo rma t:
Download the NotationPlayer.pdf file from Notation Software's web site, at
http://www.notation.com/Player.php

1.1.3

Installing Notation Player
You may have obtained N o ta tio n P la y e r either via download from the Internet, or in a software
collection on CD-ROM. Either way, the setup program will be named something like
Inst_NS_Player_3_English.msi.
The number in the setup file name represents the N o ta tio n P la y e r version number. You can always
check our website at http://www.notation.com/Player.php for the latest release version of N o ta tio n
P la y e r.
T o ins ta ll N o ta tio n P la y e r:
Find the downloaded installation file on your machine or
If you did not immediately run the setup program after downloading it, or if the setup program is
located on a CD-ROM, then you will first need to find it on your system on your CD-ROM. One
way to do this is as follows:
1.

At the lower, left corner of the screen, click the Windows Start button (skip this step for
Windows 10):

or
That brings up the Windows Start menu.
2.

Select Search in the Windows Start menu.
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Windows will display the Search Results window.
3.

In the Search Results window, search for files that begin with the word "Inst" or "NS".
Windows will find Inst_NS_Player_3_English.msi file in your Internet download
directory or CD drive, and display it in the right panel of the Search Results window.

4.

With the mouse, double-click the name of the found file. That will start the setup program.

5.

Follow the steps in the N o ta tio n P la y e r setup program. If you have difficulty running the
setup program, please review the Frequently Asked Questions (FAQs) at
www.notation.com/FAQs.htm.

Once the N o ta tio n P la y e r Setup program begins, it will ask a few simple questions about
how you prefer to install the program. Answer those questions, and the installation will
complete quickly, usually within 30 seconds.

1.1.4

Finding and Starting Notation Player on Your System
Once you have installed N o ta tio n P la y e r, there are a couple of ways you can start the program. The
instructions below show you one way.
T o s ta rt N o ta tio n P la y e r a fte r ins ta lla tio n o n W ind o ws 10:
1. In the Search box on the bottom left of the screen simply type "Player".
2. In the Results area, "Player" will be displayed as an App. Click it to start it.
T o s ta rt N o ta tio n P la y e r fro m its W ind o ws p ro g ra m fo ld e r:
1.

At the lower left corner of the screen, click the Windows Start button:

or
Windows will display the Start menu.

1.1.5

2.

In the Start menu, choose Programs. A submenu with various programs on your system will be
listed.

3.

In the submenu, choose N o ta tio n P la y e r. A second submenu will be displayed, showing
various tools available for N o ta tio n P la y e r.

4.

Select N o ta tio n P la y e r from the submenu:

Setting up Your Default MIDI Playback Device
Your computer probably has more than one MIDI device that can be used for producing instrument
sounds. You will be able to hear the difference in how one MIDI device versus another plays, for
example, a grand piano sound.
A MIDI device can be "software synthesizer" on your system. Or a MIDI device can be a physical
device, most commonly an external MIDI keyboard that is connected to the computer via a USB cable
or MIDI cable.
The Quick MIDI Device Setup command in N o ta tio n P la y e r's Setup menu offers you an easy way to
choose the MIDI device that will be used for playback.
T o s e t up the MID I p la y b a c k d e v ic e in N o ta tio n P la y e r:
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1.

In the Setup menu, choose the Quick MIDI Device Setup command.
N o ta tio n P la y e r will display the Quick MIDI Device Setup dialog box:

2.

Select one of the MIDI playback devices in the list.
To use an external MIDI device that is connected to your system via a USB cable or MIDI
cable, select a MIDI device that has "MIDI Out" or "Out" in its name.

3. To test the sound for the selected playback device, click the Test Playback button.
N o ta tio n P la y e r will display and play a 12-note chromatic scale. The notes will be
highlighted as they play. Also, the green playback indicator in the Quick MIDI Device Setup
window will display a bright green color as the notes are played. Upon completion of the
playback, N o ta tio n P la y e r will close the window that displays the notes.
If the device is an "internal" device on your Windows system, then you should hear sound
through the speakers connected to your soundcard. If the device is "external", such as a MIDI
keyboard capable of producing its own sound, then you should hear that device play the
sound.

1.1.6

4.

If you do not hear sound for a device when you choose the Test Playback option, then some
possible explanations and remedies are discussed in What To Do If You Do Not Hear Any
Sound.

5.

Click the OK button when you have selected the desired playback device.

6.

After you click OK, if you have already opened a song, N o ta tio n P la y e r will display a simple
dialog box that offers you the option to reassign all of the tracks of that song to the newly
assigned default device.

Uninstalling Notation Player
T o unins ta ll N o ta tio n P la y e r:
1.

In Windows 10, click the Settings button and then select "Apps".
(a) Navigate to "P la y e r 3" and click it.
(b) Click the "Uninstall" option

-- OR -2.

In the Windows Start menu, navigate to the N o ta tio n P la y e r Uninstall program and run it, as
follows:
(a) Click the Windows Start button at the bottom left corner of the screen. Windows will display
the Start menu.
(b) In the Start menu, choose Programs.
(c) In the Programs submenu, choose N o ta tio n P la y e r.
(d) In the N o ta tio n P la y e r submenu, choose U nins ta ll N o ta tio n P la y e r.

-- OR -3.

Use the Remove option of the Windows Control Panel as follows:
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(a) Click the Windows Start button at the bottom left corner of the screen.
(b) In the Start list, select the main Settings option. On Windows XP, choose the Control Panel
sub-option.
(c) In the Control Panel folder, choose Add/Remove Programs.
(d) Scroll down in the list of currently installed programs on your system to the entry for
N o ta tio n P la y e r.
(e) Click the Add/Remove button to remove N o ta tio n P la y e r from your system.

1.2

Quick Start Tutorial
The following tutorial will get you started quickly in enjoying some of N o ta tio n P la y e r's main
features. This tutorial can typically be completed in about 10 minutes.
As you follow the steps of this tutorial, you should feel free to explore side tours on your own. After
completing this tutorial, you should be able to successfully explore many of N o ta tio n P la y e r's
additional features on your own without needing to refer to this User's Guide.
There are simple steps in this tutorial
Opening a Song File on Your System
Playing the Song

1.2.1

Tutorial: Opening a Song File on Your System
N o ta tio n P la y e r can open any correctly formatted MIDI . mid or Karaoke .kar file, and transcribe it
to notation. N o ta tio n P la y e r can also open, display, and play, any Notation (.not) file created and
saved by other N o ta tio n products, such as N o ta tio n Mus ic ia n and Co mp o s e r.
This first step of the tutorial illustrates how you would open a MIDI or Notation (.not) file that you had
previously downloaded from the Internet to your system. Or, perhaps you have a MIDI file that you
created with another tool (such as a MIDI sequencer), and now you wish to view its notation with
N o ta tio n P la y e r.
This tutorial will work with an excerpt from the first movement of Mozart's 40th Symphony. You can find
the MIDI file for it, Mozart40thSymphony.mid, in your \Program Files\Notation\Songs
directory.
T o o p e n a MID I file o n y o ur s y s te m:
1.

Start N o ta tio n P la y e r, as described in Finding and Starting Notation Player on Your System.

2.

In the File menu, choose the Open command.
N o ta tio n P la y e r will present you with the File Open dialog box.

3.

By default, the \Program Files\Notation\Songs directory will already be opened. If
another directory is opened, then navigate to the Notation\Songs directory.

4.

Open the file Mozart40thSymphony.mid.
N o ta tio n P la y e r will display as many measures of the song as will fill the window. If you want
to see more measures in the window, click the Zoom Out

button in the main toolbar.
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This orchestration of Mozart's 40th Symphony displays the General MIDI (GM) names for the
instrument sounds, rather than the names of the instruments (Violin I, Violin 2, Viola, etc.) as
they would be displayed in a conductor's score. You will find that some MIDI files will more
faithfully represent the exact orchestration of the original composition, whereas other MIDI files
will provide an approximate orchestration that sounds better for soundcards that adhere to the
General MIDI (GM) standard.
In the next step of this tutorial, we will open the same Mozart40thSymphony.mid song by
downloading it from the Internet, using N o ta tio n P la y e r's built-in Internet browser. Therefore, let's
close the song file we have opened above.
T o c lo s e a s o ng file :
Choose the Close command in the File menu.
-- OR -Type CTRL+F4, the standard Windows shortcut for Close Window.
If you have obtained a Notation (.not) file created by N o ta tio n Mus ic ia n or Co mp o s e r, you can
similarly open it.
T o o p e n a N o ta tio n (.no t) file o n y o ur s y s te m:
1.

In the File menu, choose the Open command.
N o ta tio n P la y e r will present you with the File Open dialog box.

2.

Open the file RhapsodyInBlue.not.
This is a small excerpt of a slightly simplified arrangement of the main theme of George
Gershwin's Rhapsody in Blue:

Introduction
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Close the file, using the Close command in the File menu, or by typing CTRL+F4.

Tutorial: Playing the Song
If your computer has a soundcard, it is likely that N o ta tio n P la y e r will be able to immediately play
through your computer's soundcard to the speakers. N o ta tio n P la y e r requires that the soundcard
support MIDI, which is a certain computer music standard that almost all of today's soundcards
support.
T o p la y b a c k the c urre ntly o p e ne d s o ng :
Choose the Start Playback command from the Perform menu.
-- OR -Hit the SPACE key.
-- OR --

Click the Play

button in the toolbar at the top of the window.

A vertical blue cursor moves along in the score as the song plays, to indicate the current
playback position. The currently playing notes are highlighted in a bright pink color.
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TIP: Do you hear the music playing? If so, then Notation Player will not need any
assistance from you in setting up the MIDI sound device.
If you do not hear the song play, then follow the instructions in Quick MIDI Device
Setup. If after using the Quick MIDI Device Setup option you still do not hear sound,
then read about What To Do If You Do Not Hear Sound.
T o q uic k ly a d v a nc e fo rwa rd thro ug h the s o ng d uring p la y b a c k :

1.

Click the Fast Forward

button once to increase the playback speed by a factor of five.

2.

Click the button a second time to resume the original playback speed.

T o s to p p la y b a c k :
Choose the Stop Playback command from the Perform menu.
-- OR -Hit the SPACE key.
-- OR --

Click the Stop

button.

-- OR --

Toggle the Playback

button in the toolbar at the top of the window.

You have now completed N o ta tio n P la y e r's Quick Start Tutorial.
You will probably be able to discover most of the other features in N o ta tio n P la y e r by simply trying
out menu commands and buttons. If you are not sure what a menu or button does, remember that you
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can hold (hover) the mouse over the menu command name or button, and N o ta tio n P la y e r will
display a brief tip that explains the purpose of the command or button. Also, you do not have to worry
that you might make a mistake. Using the Undo command in the Edit menu, you can undo any recent
mistakes you might have made.

14
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Opening and Transcribing Songs
N o ta tio n P la y e r opens, displays, and plays two types of files: (1) MIDI (.mid) and Karaoke (.kar)
files, and (2) Notation (.not) files:
A MIDI file usually has a .mid file name extension.
A Karaoke file is a special type of MIDI file, which has a lyrics track normally intended to be
displayed as text without notes. A Karaoke file usually has a .kar file name extension. Most
Karaoke playing programs display only the lyrics; but Notation Player displays both the lyrics
and the notes. Since a Karaoke is technically only a special type of MIDI file, this Notation
Player documentation will sometimes use the terminology MIDI file to refer to both .mid and
.kar files.
A Notation file is a song file created by one of Notation Software's products, such as N o ta tio n
Mus ic ia n or N o ta tio n Co mp o s e r. A Notation (.not) file contains all of the musical
performance data of a MIDI file, plus music notation details that the author enters using one of
the N o ta tio n programs. N o ta tio n P la y e r serves as a free "reader" and "player" of Notation
files created by these other products.
Besides serving as a "reader" and "player" of Notation (.not) files, the central feature of Musician
is that it can import MIDI and Karaoke files from the Internet, or from another music software
program, and transcribe them into music notation with amazing accuracy. When N o ta tio n P la y e r
imports the MIDI or Karaoke file, it preserves all of the fine details of the musical performance.
Even though N o ta tio n P la y e r nicely rounds off notes to readable note durations, the underlying
exact timings of the notes are preserved and accurately performed by N o ta tio n P la y e r during
playback.
The topics that follow describe procedures for:
Opening a song file on your system
Viewing the song title and author information
Searching for and downloading MIDI and Notation files from the Internet
Transcribing MIDI files to notation

2.1

Opening a Song File on Your System
T o o p e n a MID I (.no t), Ka ra o k e (.no t) o r N o ta tio n (.no t) file o n y o ur s y s te m:
1.

Choose the Open command in the File menu.
-- OR -Type CTRL+O, the standard Windows shortcut for File Open.
N o ta tio n P la y e r will present the File Open dialog box.

2.2

2.

If the file is not in the default directory, navigate to the directory where it is located.

3.

Select the file in the directory.

4.

Click the Open button.

Viewing the Song Title and Author Information
Some MIDI (.mid), Karaoke (.kar), and Notation (.not) files contain song title and author information,
which you can view with the File / Song Title and Authors command.
Some MIDI files store song author and copyright information as the names of empty tracks. It is
distracting to see these empty tracks as empty staves when the score is displayed. Yet, it is important
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the the song author and copyright information is preserved. N o ta tio n P la y e r does this by moving the
names of empty tracks to the "Other Information" section of the Song Title and Authors window.
T o v ie w the s o ng title a nd a utho r info rma tio n:
Choose the Song Title and Authors command in the File menu.
N o ta tio n P la y e r will display the Song Title and Authors window, which includes the following
information:
song title
composer
arranger
lyricist
copyist
copyright notice
other information

2.3

Searching for and Downloading MIDI and NoteSoft Files from
the Internet
We strongly recommend that you use your favorite Internet browser to search for and download MIDI
files from the Internet. If you have associated the MIDI .mid filename extension and Karaoke .kar
filename extension with N o ta tio n P la y e r, then as soon as the download of the file has completed,
N o ta tio n P la y e r will automatically start up and open the file. You will see the MIDI or Karaoke file
transcribed to sheet music.
Also, you can use your favorite Internet browser to download MIDI files to a directory on your system.
Then you can use N o ta tio n P la y e r's File Open command to open any of the downloaded MIDI files.
Instead of using an external browser, you can use N o ta tio n P la y e r's built-in Internet browser to
download and open MIDI and Karaoke files. This built-in browser is actually Microsoft's Internet
Explorer, repackaged inside of N o ta tio n P la y e r's own window. Please note that this internal
browser will not work properly on some newer operating systems because of Microsoft's changes in
software architecture.

2.3.1

Using Notation Player's Internet Browsing Window
Please note that these instructions will only work on older systems. For Windows 10 and
other more modern systems, we recommend using your favorite browser to find files and
then download them to your Songs folder.
In order to download a MIDI , Karaoke or Notation (.not) from the Internet, you need to first navigate to
a web site that offers MIDI files.
T o s ta rt b ro ws ing fo r MID I file s o n the Inte rne t:
If no files are currently opened, then click the Browse Internet icon:
-- OR --
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Choose the Browse Internet for MIDI Files command in the File menu. This will open N o ta tio n
P la y e r's built-in Internet browsing window. By default, it will display Notation Software's web
page

Finding MIDI files

You can instruct N o ta tio n P la y e r to always initially open some alternative web page by using
the Set Initial Web Page command.
T o na v ig a te to o the r we b p a g e s o n the Inte rne t:
Position the mouse over highlighted text. Near the bottom of the browse window, you will see a
web page location. If you click the mouse on the highlighted text, the browser will take you to
that location.
-- OR -Type in the location (URL) of the web page in the "Location" box near the top of the page. It is
not necessary for you to type in the leading "http://" characters. Press the ENTER key to
complete the entry of the location.
-- OR -To view the previous web page that you last visited, click the Back
button. If you have
browsed back to a previous web page and want to return to the more recently reviewed page,
click the Forward

button.

-- OR -Click the down arrow at the right side of the "Location" box to list the most recent web pages
you have visited. Then click one of the web page locations in the list to view the page again.

Opening and Transcribing Songs
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T o inte rrup t the d o wnlo a d ing o f a we b p a g e :
Click the
button. This option is handy if the web page is taking too much time to
download, which sometimes happens if the web site offering the page is temporarily not
working or too busy.
T o e xit the b ro ws e r:
Click the

button.

-- OR -In the Window menu or File menu, choose the Close Window command.

2.3.2

Specifying the Initial Web Page for Browsing
Please note that these instructions will only work on older systems. For Windows 10 and
other more modern systems, we recommend using your favorite browser to find files and
then download them to your Songs folder.
You can specify a default web page. Then, whenever you use the Browse command, Notation Player
will first take you to that web page to begin your search.
T o s p e c ify the initia l we b p a g e fo r b ro ws ing :

2.3.3

1.

In the browser window, navigate to the web page that you wish to establish as the initial web
page for browsing.

2.

In the Preferences menu of the browser window, choose the Set Initial Web Page command. It
will display a dialog box that looks like this:

3.

The dialog box will display the web page location (URL) for the page you are currently
viewing. You can enter a different web page location if the currently viewed page is not the one
you intend.

4.

Click the OK button.

Downloading MIDI Files and Zip Files
Please note that these instructions will only work on older systems. For Windows 10 and
other more modern systems, we recommend using your favorite browser to find files and
then download them to your Songs folder.
See Using N o ta tio n P la y e r's Internet Browsing Window for instructions in starting N o ta tio n P la y e r's
built-in Internet browser.
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Once you have arrived at the initial web page for browsing, you can browse around the Internet,
searching web sites that offer MIDI files, Karaoke files, or Zip files containing MIDI or Karaoke files. The
techniques you should use for finding MIDI files with the built-in browser are the same that you would
use in Internet Explorer or your favorite browser.
You can perform searches using general search engines such as Google. Just type
"www.google.com" for the Location in N o ta tio n P la y e r's browser window, and hit the

key.

Once you arrive at Google, do a search on "midi" and the name of the song or artist you are interested
in. For example, do a search on "midi twinkle" to look for MIDI files for the children's song Twinkle
Twinkle Little Star.
When you visit a web page that publishes MIDI files, you may find the files in a couple of different
formats. Also, the links might be displayed in some different ways. MIDI files usually have a .mid
filename extension. Karaoke files have a .kar filename extension. Sometimes just the name of the
MIDI or Karaoke file is displayed. In other cases, the song title is displayed instead of the file name. In
this case, you can confirm that the highlighted text corresponds to a MIDI or Karaoke file by moving the
mouse cursor over the highlighted text and noting the location (URL) displayed at the bottom of the
browse window.

Once you have found the file you want to download, the procedure is simple.
T o d o wnlo a d a MID I (o r Ka ra o k e ) file :
1.

Click the name of the MIDI music, or filename of the MIDI file shown at the web page. N o ta tio n
P la y e r will start downloading the file.
N OT E :
If the MID I file imme d ia te ly p la y s ra the r tha n s ta rting to d o wnlo a d , you
probably have a MIDI player plug-in installed on your system. Some MIDI player plugins provide an option for saving the MIDI file to your hard drive. You should use this
option, and specify your song directory as the download location. Upon completion of
the download, N o ta tio n P la y e r will automatically open the MIDI file if you have
associated N o ta tio n P la y e r with the .mid file name extension. If N o ta tio n P la y e r
does not automatically open the MIDI file, then you can open it using the Open
command in the File menu.
If you are not able to keep the MIDI player plug-in from playing the MIDI file instead of
letting you download the MIDI file, then the steps to correct this problem depend on
which particular MIDI player is installed on your system. The Notation Software web
site provides answers to Frequently Asked Questions (FAQs) regarding how to handle
such conflicts with common MIDI player plug-ins. We provide the answers at our web
site rather than in this help documentation, because the answers change over time as
new versions of MIDI player plug-ins are released by their manufacturers. Visit
www.notation.com/FAQ.htm, and search for "MIDI Player".

2.

If the download takes longer than you want, click the
download.

button. This will abort the

Opening and Transcribing Songs

19

3.

N o ta tio n P la y e r will present you with a file Save As dialog. Navigate to the directory where
you want to save the file. You can keep the same file name as downloaded, or change it now.
The file Save As dialog looks like this:

4.

Click the Transcription Options button to provide N o ta tio n P la y e r instructions for how to
transcribe the downloaded MIDI file.
This is necessary only if you want to change the Transcription Options from their most recent
settings. For details, see Transcription Options.

5.

Click the Save button to save the MIDI file.
T IP : If you find that you usually want to save MIDI files in the same directory, then turn
on the "Set as default directory" check mark in the above Save As dialog. Then,
whenever you run N o ta tio n P la y e r, it will automatically open this directory in the
Save As dialog.

6.

2.3.4

As soon as N o ta tio n P la y e r has completed the download, it will save the MIDI file in the
directory you specified above. It will then convert the MIDI file to notation, and display the
score on the screen. To start playing the music, press the play button or hit the SPACE bar.

Associating Notation Player with .MID, .KAR, and .NOT Files
Please note that these instructions will only work on older systems. For Windows 10 and
other more modern systems, we recommend using your favorite browser to find files and
then download them to your Songs folder. You can set up file associations in your favorite
browser by using the "Tools", or "Options" area and then "Default programs" (or similar
terminology) to set the file association with Notation Player 3.
You can set up Windows to always use N o ta tio n P la y e r to open a MIDI (.mid) or Karaoke (.kar)
file when you open it from Windows Explorer, or download it using the Internet Explorertm or other
browser.
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When you first installed N o ta tio n P la y e r, you were asked whether you wanted to "associate"
N o ta tio n P la y e r with .mid and .kar files. Associate is the term that Windows uses to say that a
specified program is used to open files with a certain file name extension, such as .mid or .kar. If
you did not request N o ta tio n P la y e r to be associated with .mid and .kar files when you ran the
N o ta tio n P la y e r setup program, you can still do this later, as described below. Or the other way, if
you did request N o ta tio n P la y e r to be associated with .mid and .kar files, but change your mind,
you can remove the association.
T o a s s o c ia te N o ta tio n P la y e r with MID I (.mid ) a nd Ka ra o k e (.k a r) file s :
1.

Choose the Associate Notation Player With .MID Files command in the Setup menu. N o ta tio n
P la y e r will display the following dialog box:

N o te : On Windows Vista and Windows 7, the above dialog box is replaced with a
different set of instructions.
2.

Add a checkmark next to each of the two options and click the OK button.

T o re mo v e the a s s o c ia tio n o f N o ta tio n P la y e r with MID I (.mid ) a nd Ka ra o k e (.k a r)
file s :
Follow the same procedure as above, but remove the checkmark(s).
After you remove the association of N o ta tio n P la y e r with .mid or .kar files, N o ta tio n
P la y e r will restore the previously associated MIDI program with .mid or .kar files. If the
previously associated MIDI program no longer exists on your system, then you will need to
associate another MIDI program with .mid or .kar files, as described in the next procedure.
T o ma nua lly a s s o c ia te a no the r p ro g ra m with MID I (.mid ) a nd Ka ra o k e (.k a r) file s :
The instructions below use MIDI files as the example, but they apply equally to Karaoke files.
N o te : On Windows Vista and Windows 7, choose the Associate Notation Player With .MID
Files command in the Setup menu, and follow the instructions there, instead of the
procedure below.
1.

Right-click the Windows Start button at the lower left corner of the screen.

2.

Choose Explore from the Start menu.

3.

In the Tools menu of the newly opened Explore (or Start Menu) window, choose the Folder
Options command.

4.

In the Folder Options window, click the File Types tab.
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5.

In the File Types window pane, scroll down in the list of Registered File Types until you find the
extension MID. Or, if you do not find the MID extension, click the New button, and add an entry
for the MID file extension.

6.

Once you select the MID file extension, click the Add or Change button for Opens With.
Windows will display an Open With dialog with a list of all of the programs registered on your
system.

7.

In the Open With dialog, choose the program you wish to newly associate with the MID file
extension.

Transcribing MIDI Files to Notation
When you import a MIDI file, N o ta tio n P la y e r transcribes the musical performance in the MIDI file to
music notation. The data stored in the MIDI file is basically a recording of what notes (pitches) are
played at what exact times by various instruments (in tracks).
A good way to understand transcription is to think of the MIDI performance as a piano roll used on
player pianos that were popular in the late 1800's and early 1900's. The holes in the piano roll
determine what notes are played at what times. If you unroll the piano roll horizontally, you will observe
that the holes mark the beginning and ending times of played notes. The vertical position of the holes
determine the pitch of the notes.
Here is an example of a piano roll:

Basically, the above piano roll is all that N o ta tio n P la y e r is given when it must transcribe a MIDI file,
to notation. N o ta tio n P la y e r is able to cleverly transcribe the above piano roll information into
notation. This example happens to be the Bach Minuet file, minuet.mid , that is installed in the C:
\Program Files\Notation\Songs directory. The result of the transcription looks like this:

N o ta tio n P la y e r must make many decisions about how to transcribe any given MIDI performance to
notation. These decisions are similar to those that a trained musician would make when he or she
hears music and writes down the notes on paper. (Very few musicians have this special training in
"music dictation".)
Some decisions about how to transcribe the music are closely related to the style of the music.
N o ta tio n P la y e r does not attempt to determine what the style of music is, in order to make the
appropriate decisions in transcribing the MIDI performance to notation. Instead, N o ta tio n P la y e r lets
you make a few simple choices about how to transcribe the music.
In particular, you can instruct N o ta tio n P la y e r to:
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Choose one or the other of Standard versus Swing style in determining how to display rhythms
such as illustrated here:

Detect and display split upper and lower voices as opposed to single voice, as illustrated
here:

Remove overlapping notes in order to reduce the number of ties, as illustrated here:

Remove rests smaller than some size you specify, such as a quarter rest, as illustrated here:

Detect grace notes, trills, and tremolos.

The options described above are offered in the Transcription Options dialog described in the next
topic. N o ta tio n P la y e r offers you the opportunity to specify the transcription options in several
circumstances:
As you import a MIDI file, click the Transcription Options button in the File Open dialog box.
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As you download a MIDI file from the Internet, click the Transcription Options button in the File
Save As dialog box.
With the Re-Transcribe command in the Score menu.
A b o ut Qua ntiza tio n
If you have used other music notation programs with a transcription feature, that feature
very likely includes an option for specifying the "quantization level". Such an option
tells the program to round note duration values and attack times to the nearest, say,
thirty-second note, or sixteenth note. You may wonder why such an option is missing in
N o ta tio n P la y e r. The reason is that N o ta tio n P la y e r has a better way of
determining note durations and attack times than simply rounding to some nearest
value. Such quantization only works well for fairly simple rhythms. Notes with long
values tend to be "over-enthusiastically" notated with extra dotted values and ties.
Separate notes with short values and small differences in attack times may be
incorrectly collapsed into chords. N o ta tio n P la y e r does a much better job at
transcribing rhythms than notation programs that use a simple quantization approach.
N o ta tio n P la y e r analyzes the rhythmic context of each note to determine what
quantization level to apply to the note.

2.4.1

Transcription Options
For an overview of how N o ta tio n P la y e r transcribes an imported MIDI file to music notation, see the
preceding overview topic, Transcribing MIDI Files to Notation.
The Transcription Options dialog box offers you the opportunity to determine how N o ta tio n P la y e r
transcribes an imported MIDI file to music notation:

There are several ways that you can access the Transcription Options dialog box:
Choose the Transcription Options command in the Setup menu.
Click the Transcription Options button in the File Save As when downloading a MIDI file from
the Internet.
Choose the Re-Transcribe command in the Score menu (this option allows you to select only
certain staves to re-transcribe).
The transcription options you choose will be applied in all subsequent transcriptions, not only in the
current session in which you are running N o ta tio n P la y e r, but also in future sessions.
Each of the transcription options are described below.
D e te c t a nd D is p la y V o ic e s
The difference between the two voice options is illustrated here:
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Choose the Split (Upper and Lower) Voices option under these circumstances:
The MIDI file includes keyboard parts, or your recording is at a music keyboard.
You want the notation to clarify how some notes are held for longer durations while other
notes played at the same time are held for shorter durations.
You can simplify the notation by choosing the Single Voice Only option, but only if you also
choose the Remove Overlaps of Notes option. The above single voice example is actually more
difficult to read than the split voice example, because the overlapping of notes have not been
removed.
R e mo v e Ov e rla p s o f N o te s
The result of choosing the Remove Overlaps of Notes option is illustrated here:

Removing overlaps of notes reduces the number of ties, and thus simplifies the overall notation.
However, this also results in notation that less accurately represents the actual duration of notes.
If you are working with keyboard parts and find that transcriptions have too many ties, you first
should consider choosing the Split (Upper and Lower) Voices options. Then, if there are still too
many ties, use the Remove Overlaps of Notes option.
If you are working with single-note instrument or vocal parts, then choose the Single Voice Only
option and the Remove Overlaps of Notes option.
R e d uc e R e s ts S ma lle r T ha n...
If you find that N o ta tio n P la y e r transcribes with too much accuracy with respect to the use of
dotted note values and rests, then you can instruct N o ta tio n P la y e r to eliminate any rest that is
smaller than a certain size (quarter rest, eighth rest, or sixteenth rest), as illustrated here:

In general, you should choose a smaller minimum rest size for slow tempos, and a larger minimum
rest size for fast tempos. In slow tempos, you may want the notation to clarify the duration of notes
and rests. In fast tempos, you may want to reduce the complexity of the notation by eliminating
smaller rests.
R hy thm S ty le
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In jazz and swing styles of music, triplets with a missing middle member are quite common. There
is a convention in jazz and swing notation that simplifies the notation of such partial triplets by
displaying the two members of the triplet as a simple pair of notes with equal durations. You can
instruct N o ta tio n P la y e r which style of rhythm notation to use, as illustrated here:

T ra ns c rib e Orna me nts
N o ta tio n P la y e r recognizes grace notes, trills and tremolos. Instead of literally writing the notes
of the ornamented performance, N o ta tio n P la y e r displays the standard notation for the type of
detected ornament. All of the details of the ornament's performance are preserved-- the exact
timing of the notes and the loudness of each note. You can view the written-out performance at any
time, and edit the performance. While viewing the written-out performance you can edit details of
the performance-- the timing and loudness of the notes.

2.4.2

Re-Transcribing a MIDI File
When you import a MIDI file, N o ta tio n P la y e r applies the transcription options that you have most
recently specified in the Transcription Options dialog. If you are not satisfied with the results of the
transcription, you might be able to improve the results by choosing different transcription options. You
can select specific tracks to which the new transcription options are applied.
T o re -tra ns c rib e s p e c ifie d tra c k s in a s o ng :
1.

Choose the Re-Transcribe command in the Score menu.
N o ta tio n P la y e r will display the Re-Transcribe dialog box, such as the following:
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2.

Select the staves that you wish to re-transcribe. Click a staff name to toggle its selection. Use
the buttons below the list of staves to select all of the staves, or to unselect all of the staves so
that you can then select individual staves.

3.

The re-transcription options are the same as those in the Transcription Options dialog box.
Refer to the Transcription Options topic for a description of the options for voices, overlaps of
notes, minimum rest size, and rhythm style.

4.

If you wish to set the new transcription options as the default for future transcriptions, click the
Set As Default button. This is equivalent to choosing the Transcription Options command in
the Setup menu, and selecting the same options.
N OT E : Some MIDI files are recorded without reference to a metronome.
You can tell whether a MIDI file has been recorded without reference to a metronome
by following this simple procedure: After N o ta tio n P la y e r has opened the MIDI file,
start playback. Watch the vertical playback cursor (blue, by default) move along with
the playback. Listen to playback and start tapping the beats with you hand or foot.
Does the playback cursor move in synchronization with the beats you hear? If so, the
MIDI file was indeed recorded with reference to a metronome. If the beat movements of
the playback cursor do not relate to the beats you hear, then the MIDI file was recorded
without reference to a metronome. N o ta tio n P la y e r cannot correctly analyze the
rhythms in such MIDI files, but N o ta tio n Co mp o s e r has a Rebar feature that allows
you to get sheet music from such files.
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Navigating through Notation Player and the Score
This section is organized as follows:
Parts of the Notation Window
Showing and Hiding Parts of the Window
Menus
Toolbar
Play Buttons
Volume Control
Zoom-In and Zoom-Out Buttons
Window View and Page View
Viewing Multiple Songs at a Time
Scrolling, Resizing and Zooming the Window
Scrolling the Window
Resizing the Window
Zooming the Window
Navigating through Pages of the Score
First Page, Next Page, Previous Page, and Last Page
Go to a Measure or Page
Go to a Rehearsal Mark
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Parts of the Notation Window
The following picture identifies the main elements of N o ta tio n P la y e r's window:

Each part of N o ta tio n P la y e r's window is briefly described below. Some parts of the window are
described in more detail throughout the remainder of this section.
T o o lb a r
The toolbar offers a variety of buttons and controls for playing back songs; controlling the volume
level; zooming in and out; and adding key signatures and clefs. For details, see the Toolbar topic.

S o ng T a b s
The song tabs let you quickly access any song that you have open with a single click of your
mouse.

S ta tus B a r
The status bar shows:

3.1.1

--

the most recent tip or error message.

--

the Page Scroller, which allows you to quickly jump to any location in the score.

--

the page number of the currently displayed page.

Showing and Hiding Parts of the Window
N o ta tio n P la y e r offers options to show or hide most of the parts of the window described in the
previous topic: the toolbar and the status bar.
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T o s ho w o r hid e a p a rt o f the N o ta tio n P la y e r wind o w:
In the View menu, add or remove a checkmark next to the Show Toolbar or Show Status Bar
menu item.

3.1.2

Menus
N o ta tio n P la y e r offers a convenient way for you to learn about the purpose and use of any menu
command.
T o d is p la y H e lp fo r a me nu c o mma nd :
1.

Click the menu, and submenu if needed, that has the command.

2.

Hold the mouse over the text of the command name.

3.

Without clicking the mouse, hit the F1 key. This will display the on-screen help topic that
describes the purpose and use of the selected menu command.

Listed below is a summary of each main menu selection in N o ta tio n P la y e r.

File
Open, download from the Internet, and close MIDI, Karaoke and Notation (.not ) files.
E d it
Add key signatures and clefs. Undo and redo transactions.
V ie w
Determine how the N o ta tio n P la y e r window displays the score (in Window View or Page View)
and shows or hides the palette and status bar.
S c o re
Format the score. Re-transcribe the score.
P e rfo rm
Play and control the playback of a song.
S e tup
Select the MIDI device for playback.
Set up N o ta tio n P la y e r as the program to automatically play MIDI (.mid) and Karaoke (.kar )
files.
Set up transcription options.
P a rts
Select the part (MIDI file track) you wish to display, or "All Parts".
W ind o w
Within N o ta tio n P la y e r's window, arrange the size and positions of score windows for multiple
songs.
H e lp
Get help from N o ta tio n P la y e r's online documentation or from Notation Software's web site.
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Toolbar
The toolbar is displayed along the top of N o ta tio n P la y e r's window. The buttons and controls in the
toolbar are grouped as indicated:

Each group of buttons and controls are described in the topics that follow:
Browse the Internet for MIDI Files
Play Buttons
Volume Controls
Zoom-in and Zoom-Out Buttons
T o s ho w o r hid e the to o lb a r:
Toggle the Show Main Toolbar checkmark in the View menu.
3.1.3.1

Play Buttons
The following buttons for controlling playback and recording are located in N o ta tio n P la y e r's
toolbar:

R e wind o r P re v io us P a g e
During playback, click this button to immediately re-start playback again at the beginning of the
score.
If playback is not in progress, then single-click this button to go to the previous page. Double-click
it to "rewind" to the beginning of the score. The next time you hit the Playback
the SPACE key, playback will start at the beginning of the score.

button, or hit

S ta rt/ S to p P la y b a c k
Click this button to start playback. This button is shown in a down position if playback is in
progress. If playback is in progress, click either this button or the Stop
playback.

S to p

button to stop the
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Click this button to stop playback that is in progress.

Fa s t Fo rwa rd o r N e xt P a g e
If playback is in progress, click this button to quickly play through the song at five times normal
speed.
If playback is not in progress, then single-click this button to go to the next page.
3.1.3.2

Volume Control
The following volume control is located in N o ta tio n P la y e r's toolbar:

During playback you can adjust the overall volume level by dragging the volume control slider to the
right or left with the mouse, or by clicking the mouse on the left or right side of the slider knob.
3.1.3.3

Zoom-In and Zoom-Out Buttons
The following buttons in N o ta tio n P la y e r's toolbar let you temporarily enlarge or shrink the size of the
score notation viewed on the screen:

Zoom In makes everything look bigger, and Zoom Out makes everything look smaller.

3.2

Window View and Page View
N o ta tio n P la y e r offers two ways to view a score on the screen: Window View and Page View.
In Window View, N o ta tio n P la y e r arranges the pages of the score as though the page size were
exactly the size of the window. If you change the window size, N o ta tio n P la y e r will automatically and
quickly repaginate the score for the new "page size", which is, in this case, the window size.
In Page View, N o ta tio n P la y e r displays an image of the page as it would be printed, which is usually
larger than what can be seen all at once in the window. Therefore, in Page View, N o ta tio n P la y e r
usually displays scrollbars that enable you to scroll horizontally and/or vertically in the page. In Page
View you can view the entire page by using the Zoom Out command.
T IP : Page View is the same thing as Print Preview.
Some software programs offer a Print Preview command, which enables you to
preview pages exactly as they would be printed. N o ta tio n P la y e r's Page View
command does the same thing. Please note that P la y e r does not print scores but is a
viewer and audio audition player only.
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In Window View, N o ta tio n P la y e r evenly spaces the measures so that the barline of the last visible
measure is right-justified in the window. As many measures are displayed as can comfortably fit
horizontally. If more than one system (also called a "line", which includes multiple staves) can be
displayed in the window, then multiple systems are displayed. If only one system can be displayed,
but it has more staves (tracks) than can be shown without crowding, then the window adds a vertical
scrollbar that enables you to view the lower staves.
In Page View, N o ta tio n P la y e r simulates the layout of the notation symbols as they would appear on
a printed page.
T o v ie w the s c o re in W ind o w V ie w:
Choose the Window View command in the View menu.
T o v ie w the s c o re in P a g e V ie w:
Choose the Page View command in the View menu.

3.3

Viewing Multiple Song Files at a Time
You can open multiple songs in N o ta tio n P la y e r and view them in separate sub-windows. Normally,
you will see one song at a time. However, you can arrange the N o ta tio n P la y e r window so that you
can see multiple songs at the same time. You might want to do so in order to compare the notes in two
songs.
T o o p e n a s e c o nd s o ng in N o ta tio n P la y e r:
Open the file as usual, using the Open command in the File menu, or download and open a
MIDI file from the Internet.
T o c ha ng e the v ie w fro m o ne s o ng to a no the r tha t ha s b e e n o p e ne d :
In the left hand side of the window, select the song tab for the song you wish to view.
T o v ie w multip le o p e ne d s o ng s a t the s a me time :
In the Window menu, choose the Cascade, Tile Horizontally, or Tile Vertically command.
These are standard Windows commands for organizing multiple windows within a single
application. Try them out to see how they work.
After you have used one of these commands, you can resize the individual song windows
within N o ta tio n P la y e r's overall window by dragging sides or corners of the windows with the
mouse.

3.4

Scrolling, Resizing and Zooming the Window
The N o ta tio n P la y e r window shows some portion of the score at any given time. In Page View, the
window shows some or all of one printed page of the score. In Window View, the window shows some
range of measures of the score-- as many as will fit in the window.
The window will display a vertical scrollbar in the following circumstances:
In Page View, if the entire height of the page does not fit in the window.
In Window View, if only part of one system fits in the window.
The window will display a horizontal scrollbar in the following circumstances:
In Page View, if the entire width of the page does not fit in the window.
In Window View, if only part of one measure fits in the window.
If a vertical and/or horizontal scrollbar is present in the window, then you can use it to scroll the window,
to see other parts of the page in Page View, or other staves of a system in Window View, or other
beats of a measure in Window View. You can also scroll from one page to the next or previous. If your
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mouse has a scroll wheel, you can use it to scroll the window. You can also use keyboard shortcuts,
such as PAGEDOWN to scroll down through a large portion of the page, and CTRL+PAGEDOWN to
advance to the top of the next page.
If you want see a larger portion of the score in the window, you can resize the window to see more. Or
you can use the Zoom Out command to make the notes smaller and therefore view more notes at
once.
If are editing the score and need to increase the accuracy of the placement of objects in the score, you
can use the Zoom In command to make the notes and annotations larger.
All of the options summarized above are described in detail in the topics that follow.

3.4.1

Scrolling the Window
N o ta tio n P la y e r displays a horizontal and/or vertical scrollbar along the right and bottom edges of
the window if the page does not fully fit within the window.
T o s c ro ll the c urre nt p a g e d is p la y e d in the wind o w:
If there is a vertical scrollbar, hit the PAGEDOWN or PAGEUP key to scroll the window by
almost the full height of the window. Alternatively, click the mouse cursor in an empty area of
the scrollbar.
-- OR -To scroll by smaller amounts, move the horizontal or vertical scrollbar button with the mouse.
-- OR -If your mouse has a scroll wheel, scroll it up or down to scroll the window vertically.
T o c o ntinue s c ro lling to the ne xt o r p re v io us p a g e :
Hit the PAGEDOWN or PAGEUP key for the next or previous page.
-- OR -When you reach the bottom of a page, click the bottom vertical scroll button
reach the top of the page, click the top vertical scroll button.

; or when you

-- OR -If your mouse has a scroll wheel, continue scrolling it up or down to scroll the window vertically.
N o ta tio n P la y e r will hesitate for about a half second between each page, so that you do not
unintentionally overshoot the next page.
T o a d v a nc e to the to p o f the ne xt o r p re v io us p a g e , witho ut s c ro lling thro ug h the re s t
o f the c urre nt p a g e :
Type CTRL+PAGEDOWN for the next page, or CTRL+PAGEUP for the previous page.
Also see Navigating through Pages of the Score.

3.4.2

Resizing the Window
To change the size of N o ta tio n P la y e r window, use the mouse to drag one of the corners or edges
of the window. As with any Windows program, to "drag" the window corner or edge means to hold the
mouse down, starting at the corner or edge, and move the mouse to the new position before releasing
the mouse button. In Window View, N o ta tio n P la y e r automatically and quickly repaginates the score
so that each page exactly fits the window size.
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Zooming the Window
N o ta tio n P la y e r enables you to change the magnification of the score displayed on the screen.
"Zooming in" increases the magnification so that the music symbols appear larger. "Zooming out"
makes the symbols appear smaller, so that more of the musical score appears at once in the window.
Although you can specify exact zoom percentage levels with the Zoom Percentage command in the
View menu, N o ta tio n P la y e r may limit small zoom values to 30% or 40% if you are using Windows
Millennium or 98. On Windows XP, 2000 and NT, N o ta tio n P la y e r can handle arbitrarily small zoom
levels.
N OT E : Changing the zoom level affects only the size of music symbols as displayed
on the screen.
T o c ha ng e the zo o m le v e l:
1.

Choose the Zoom command in the View menu, and the Zoom In or Zoom Out command from
the Zoom submenu.

-- OR -2.

Type Z+

to zoom in, or Z+

to zoom out.

-- OR --

3.

In the toolbar, click the

button to zoom in, or the

button to zoom out.

-- OR -4.

To change the zoom level to a specific percentage magnification, choose the Zoom
command in the Zoom menu, and the Zoom Percentage command in the Zoom submenu.

T o re s e t the zo o m le v e l b a c k to 100% :
1.

Choose the No Zoom command from the Zoom submenu.

-- OR -2.

3.5

Type Z+ENTER.

Navigating through Pages of the Score
You can go to different pages of the score by referring to any of the following:
Page number.
Measure number.
Rehearsal mark.
You can accomplish this by using:
Commands in the Go To submenu of the View menu.
Keyboard shortcuts, such as CTRL+PAGEDOWN for next page.

The Fast Forward

and Rewind

buttons in the main toolbar.

For details about the above navigation options, see the topics that follow.
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First Page, Next Page, Previous Page, and Last Page
In Page View, the page on the screen is an image of the page as it would be printed. In Window View,
the page on the screen simulates a printed page that is exactly the size of the window. In either Page
View or Window View, you can advance forward and backward through the pages.
If the song is currently playing when you use any of the First Page, Next Page, or Previous Page
commands, then the song will continue playing where it was, without jumping to the new page. After a
few seconds, N o ta tio n P la y e r will return to the page that is currently playing. However, if you use one
of these commands during playback and you decide you would like playback to jump to the new
page, just click on that page.
T o a d v a nc e to the ne xt o r p re v io us p a g e :
Choose the Go To command in the View menu, and Next Page or Prev Page in the GoTo
submenu.
-- OR -Type SHIFT+PAGEDOWN for next page, or SHIFT+PAGEUP key for previous page.

Click the Fast Forward
page.

or Rewind

button in the main toolbar, for the next or previous

T o g o to the firs t o r la s t p a g e o f the s c o re :
Choose the Go To command in the View menu, and First Page or Last Page in the GoTo
submenu.
-- OR -Type CTRL+HOME for first page, or CTRL+END key for the last page.
-- OR --

Double-click the Rewind
last page.

3.5.2

or Fast Forward

button in the main toolbar, for the first or

Go to a Measure or Page
In Page View, the page on the screen is an image of the page as it would be printed. In Window View,
the page on the screen simulates a printed page that is exactly the size of the window. In either case,
the pages are numbered, as indicated in the bottom right corner of the window:

If the page count is reported as ". . ." instead of a number, this means that N o ta tio n P la y e r is still
busy formatting remaining pages of the score.
T o g o to a s p e c ific p a g e o f the s c o re :
1.

Choose the Go To command in the View menu, and Go to Page in the Go To submenu.
You will be presented with a dialog to enter a page number.

2.

Enter the page number.
If you enter a page number beyond the end of the score, N o ta tio n P la y e r will display the last
page of the score.

T o g o to a s p e c ific me a s ure o f the s c o re :
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1.

Choose the Go To command in the View menu, and Go to Measure in the Go To submenu.
You will be presented with a dialog to enter a measure number.

2.

Enter the measure number.
If you enter a measure number beyond the end of the score, N o ta tio n P la y e r will display the
last page of the score.

T o g o to the b e g inning o f the s c o re :

Double-click the Rewind

button

-- OR -Choose the Go To command in the View menu, and First Page in the Go To submenu.
-- OR -Type Ctrl-Home.

T o g o to the e nd o f the s c o re :

Double-click the Fast Forward

button.

Choose the Go To command in the View menu, and Last Page in the Go To submenu.
-- OR -Type Ctrl-End.
If the song is currently playing when you use any of the above commands, then the song will continue
playing where it was, even though you will be looking at a different page. After a few seconds,
N o ta tio n P la y e r will return to display the page that is currently playing. If after using Go To during
playback you want playback to jump to that page, just click somewhere on that page.
If the song is not currently playing when you use Go To command, then the playback position (the
song location where playback will resume) will be set to that page. To view another page without
changing the playback position, use Next Page or Previous Page one or more times to move to that
page. The Next Page and Previous Page commands do not change the playback position.

3.5.3

Go to a Rehearsal Mark
A Notation (.not ) (but not MIDI (.mid ) or Karaoke (.kar ) file) may include rehearsal marks there were
added by the author using N o ta tio n Mus ic ia n or Co mp o s e r.
T o g o to the lo c a tio n o f re he a rs a l ma rk :
1.

Choose the Go To command in the View menu, and Rehearsal Mark in the Go To submenu.
N o ta tio n P la y e r will display the Go To Rehearsal Mark dialog box.

2.

In the dialog box, select the rehearsal mark that you want to go to.

Playing Songs
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Playing Songs
With N o ta tio n P la y e r you can play back a song while viewing the score on the screen. N o ta tio n
P la y e r highlights notes as they are played, and automatically turns pages.
This section describes:
Quick MIDI Device Setup
Starting and Stopping Playback
Fast Forwarding
Changing the Song Position During Playback
Turning Off Stuck Notes
Controlling Overall Volume Level
Playing or Ignoring Repeats and Endings During Playback
What to Do if You Do Not Hear Sound

4.1

Quick MIDI Device Setup
Most computer systems include MIDI soundcards and alternative synthesizers (which we call MIDI
devices) for creating instrument sounds for MIDI playback. You might find it helpful to think about a
synthesizer (MIDI device) as an orchestra ready to play various kinds of instrument sounds at your
request. Your system most likely has a couple of MIDI devices, which are like different orchestras with
different personalities or sound qualities.
The Quick MIDI Device Setup command in the Setup menu lets you quickly select and test the
alternative MIDI devices. You should use the Quick MIDI Device Setup command especially if you do
not hear any sound when you first run N o ta tio n P la y e r, or after you have installed a new soundcard.
The MIDI playback device that you select in the Quick MIDI Device Setup window will be the default
playback device assigned to any new MIDI or Karaoke file you subsequently open.
If your soundcard is externally connected via a MIDI cable to a MIDI keyboard (or MIDI guitar or other
input device), then the Quick MIDI Device Setup command lets you quickly test whether the connection
to your MIDI keyboard is working.
T o te s t a nd s e le c t a MID I p la y b a c k d e v ic e o n y o ur s y s te m:
1.

Choose the Quick MIDI Device Setup command in the Setup menu.
N o ta tio n P la y e r will display the Quick MIDI Device Setup window, as illustrated here:

2.

To test the sound for a playback device, select one in the dropdown list, and then click the
Test Playback button.
N o ta tio n P la y e r will display and play a 12-note chromatic scale. The notes will be
highlighted as they play. Also, the green playback indicator in the Quick MIDI Device Setup
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window will display a bright green color as the notes are played. Upon completion of the
playback, N o ta tio n P la y e r will close the window that displays the notes.
If the device is an internal device on your Windows system, then you should hear sound
through the speakers connected to your soundcard. If the device is external, such as a MIDI
keyboard capable of producing its own sound, then you should hear that device play the
sound.
3.

If you do not hear sound for a device when you choose the Test Playback option, then some
possible explanations and remedies are discussed in What To Do If You Do Not Hear Any
Sound.

4.

Click the OK button when you have selected the desired playback device.

5.

After you click OK, if you have already opened a song, N o ta tio n P la y e r will display a simple
dialog box that offers you the option to reassign the song to the newly assigned default
device.
N OT E : Notation (.not) files may assign tracks to more than one device. If your system
has Windows MIDI output ports named exactly as those of the author of the Notation
file, then you will the tracks will be correctly assigned on your system, regardless of
which MIDI device you select in the above dialog box.
If your system does not have the same Windows MIDI output ports as those used by
the author of the Notation file, then you will be able to assign only one device to all of
the tracks with N o ta tio n P la y e r. Other versions of N o ta tio n (Mus ic ia n and
Co mp o s e r) support reassigning multiple devices to the tracks.

4.2

Starting and Stopping Playback
T o s ta rt p la y b a c k :
1.

Choose the Start Playback command from the Perform menu.

-- OR -2.

hit the SPACE key.

-- OR --

3.

Click the Play

button in the toolbar at the top of the window.

T o s to p p la y b a c k :
1.

Choose the Stop Playback command from the Perform menu. (The Stop Playback menu item
replaces the Start Playback menu item while playback is in progress.)

-- OR -2.

hit the SPACE key.

-- OR --

3.

Click the Stop

button in the toolbar at the top of the window.

-- OR --

4.

Toggle the Play

button in the toolbar at the top of the window.

Playing Songs

4.3

39

Fast Forwarding
T o te mp o ra rily fa s t fo rwa rd thro ug h the s o ng d uring p la y b a c k :

Click the Fast Forward

button once to increase the playback speed by a factor of five.

Click the button a second time to resume the original playback speed.

4.4

Changing the Song Position During Playback
While the song is playing back, you can immediately change the playback position by clicking the
mouse elsewhere on the same page or on another page.
During playback you can change the currently displayed page, even if the music is playing from a
different page. Use the Next Page or Prev Page commands of the Page menu, or hit the PAGEDOWN
or PAGEUP keys. Playback will continue uninterrupted, without changing its song position. This feature
is intended to offer you the opportunity to look ahead (or behind) in the score, without having to commit
to a decision to change where the song is currently playing.
If you then click somewhere on the currently displayed page, playback will immediately jump to that
position.
If you do not click anywhere after moving to another page,N o ta tio n P la y e r will, after a few seconds,
return to the page that is currently playing.

4.5

Turning Off Stuck Notes
Occasionally, you may hear stuck notes that continue sounding indefinitely. This can happen if the
connection to your MIDI device is temporarily disrupted, so that it does not signal the "note-off"
corresponding to a preceding "note-on".
If you hear stuck notes, you can turn them off, either during playback, or after playback has completed.
T o turn o ff s tuc k no te s :
1.

Choose the Turn Off Stuck Notes command from the Perform menu.

-- OR -2.

Type CTRL+SHIFT+S.

Note that this command not only turns off the stuck notes but also turns off any other notes that happen
to be playing.

4.6

Controlling the Overall Volume Level
If you do not hear any sound during playback, then see What To Do When You Do Not Hear Any
Sound.
There are several ways that you can control the volume level for playback:
1.

Turn the volume level up or down on the speakers connected to your computer.

2.

Use N o ta tio n P la y e r's volume control, located in the main toolbar:
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With N o ta tio n P la y e r's volume control, you can dynamically change the volume level of one
or more selected instruments during playback.
3.

Use the Windows volume control in the Windows task bar:

Windows will then display the following sound volume level control:

Move the volume lever up and down to increase and decrease the volume level.
4.

On some versions of Windows, the volume level for playback of MIDI can be controlled
separately from the volume level for playback of other types of audio. This feature is
particularly useful when you find, for example, that MIDI playback generally sounds a lot
different than the Windows welcome sound, or the playback of others kinds of sound files.
To separately control the volume level for MIDI, click the Windows Start menu at the bottom,
left corner of the screen. Windows will display a pop-up menu. Choose the Control Panel
option, which is a suboption of Setting on some versions of Windows. In the Control Panel
folder, choose the Sounds and Multimedia (or Sounds and Audio Devices) option:

-- OR -Recent versions of Windows will display a Sounds and Audio Device Properties dialog box.
Click the Volume tab, and then the Advanced button. Windows will show the the Playback
Control dialog box, such as show below. For earlier versions of Windows, navigate to the Play
Control Panel. In the Play Control Panel, observe that there is a separate volume control for
MIDI. Adjust the MIDI Volume lever to control the volume of MIDI playback relative to that of
other types of audio playback.

4.7

Ignoring Repeats and Endings
A Notation (.not ), but not MIDI (.mid ) or Karaoke (.kar ) file, may include repeat marks and endings
there were added by the author using N o ta tio n Mus ic ia n or Co mp o s e r.
By default N o ta tio n P la y e r performs the repeats and endings during playback. However, you can
instruct N o ta tio n P la y e r to ignore them.
T o p e rfo rm o r ig no re re p e a ts a nd e nd ing s d uring p la y b a c k :
Toggle the Ignore Repeats and Endings option in the Perform menu.

4.8

What To Do If You Do Not Hear Any Sound
If you do not hear any sound during playback of a song, you should use the Quick MIDI Device Setup
to try out alternative MIDI playback devices that are available on your system.
This topic offers several possible explanations and remedies for the problem of no sound. Some
explanations and remedies are not specific to N o ta tio n P la y e r. It is quite possible that you will not
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hear MIDI playback in any MIDI program, not just N o ta tio n P la y e r. If you have explored several
possible explanations and remedies within N o ta tio n P la y e r, and still do not hear sound, it is a good
idea to determine whether the problem is just with using N o ta tio n P la y e r, or whether the problem is
common to any MIDI program on your system. A good way to do this is to try playing a MIDI file using
another MIDI program. We recommend using the Windows Multimedia Player, which is almost always
installed on a Windows system. For detailed instructions on testing MIDI playback using the Windows
Multimedia Player, see the procedure at the end of this topic.
The first test you should do within N o ta tio n P la y e r is to try the Test Playback option in the Quick MIDI
Device Setup window. If you unexpectedly do not hear sound for a particular device, then several
possible explanations and remedies are offered below. The most common explanations, and the
easiest ones to solve, are listed first:
Your sound speakers are turned off or are disconnected.
Make sure that the speakers are connected to your soundcard; that the power cord to the
speakers is connected; and that the volume level of the speakers is turned up.
Another application is using the MIDI output device.
In this case, exit the other application and try the MIDI device again in N o ta tio n P la y e r. It
may be necessary to also exit N o ta tio n P la y e r and then start N o ta tio n P la y e r again.
The volume level in N o ta tio n P la y e r is set to zero (silent).
In this case, increase N o ta tio n P la y e r's volume level.
The Windows sound volume level is set to zero, or is muted. In this case, click the following
icon in the Windows taskbar at the bottom of the screen:
on Windows 7 or Vista,

on Windows XP, or

on earlier versions of Windows

Windows will then display the following (or a similar) sound volume level control:

Make sure that the volume level is above the lowest setting, and that there is no checkmark for
Mute.
The specific volume level for MIDI playback is muted or set to an inaudible level.
On some versions of Windows, the volume level for playback of MIDI can be controlled
separately from the volume level for playback of other types of audio. Make sure that the
volume level for MIDI playback is not zero and not muted, as follows.
Click the Windows Start menu at the bottom, left corner of the screen. Windows will display a
pop-up menu. Choose the Settings / Control Panel option. In the Control Panel folder, choose
the option named "Sounds and Audio Devices" or "Sounds and Multimedia":

-- OR -Windows XP will display the Sounds and Audio Devices dialog box. Click the Volume tab.
Under "Device Volume", click the Advanced button.
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Windows will display the Playback Control panel. It looks like the following on Windows XP,
and similar to this on earlier versions of Windows:

Observe that there is a separate volume control for MIDI. Make sure that the MIDI volume level
is above the lowest setting, and that there is no checkmark for Mute.
You have opened a Notation (.not) file that assigns tracks to multiple devices. Notation Player
cannot predict how you would want to reassign the tracks to devices on your system. By
default, it assigns all of the tracks to the single MIDI device that you specify with the Quick MIDI
Device Setup command; but that might overload the device with too many (more than 16) track
assignments. In that case, some tracks may not be heard, or might conflict with other tracks.
You can correct this somewhat rare problem by using the Reassign MIDI Device command in
the Perform menu.
You selected an external playback device, but there is no external MIDI device, such as a
MIDI keyboard, connected via a MIDI cable to the MIDI Out connector of your soundcard.
In this case, choose an internal playback device instead of an external device.
There is a problem with the external MIDI device or cable connecting it to your computer.
If the output device is an external MIDI synthesizer or sound module connected via a MIDI
cable to the MIDI output connector of your soundcard, then there are a couple of reasons why
you may not hear any sound.
--

Make sure that the output device power is turned on.

--

Make sure that the cable is connected to the MIDI connector of the soundcard. The other
end of the cable should be connected to the MIDI In connector of the external MIDI device.

--

Make sure that the volume level of the external device is at an audible level.

The device driver for the MIDI device is not installed correctly.
To determine if this is the case, explore whether this MIDI device can be used by another MIDI
application, such as the Windows Multimedia Player, as described in the last procedure of this
topic.
If the device cannot be used in other MIDI applications, then try re-installing the device drivers
for your MIDI soundcard.
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Sometimes problems with non-responsive MIDI devices can be resolved by updating the
driver to the most recent one available from its manufacturer. Search the Internet for the
manufacturer's web site. Look for the "download" or "drivers" section of its web site. Find and
download the driver that matches the model of your MIDI device and the version of Windows
you are using (Windows 98, Me, 2000, XP, etc.)
T o te s t the p la y b a c k o f MID I file s us ing a no the r MID I p ro g ra m o n y o ur s y s te m, a nd
us ing a s p e c ific MID I p la y b a c k d e v ic e :
TIP: Although the names of the Windows options, folders, and dialog boxes vary among
different versions of Windows, the following instructions are still basically the same.
1.

Review, and optionally change, the default MIDI playback device that Windows chooses for
playing MIDI files:
(a) With the left mouse button, click the Start button in the lower, left corner of the screen.
Windows will display the Start menu.
(b) Choose Settings in the Start menu, and Control Panel in the Settings submenu.
Windows will display the Control Panel folder.
(c) In the Control Panel folder, choose Sounds and Multimedia.
Windows will display the Sounds and Multimedia Properties window.
(d) In the Sounds and Multimedia Properties window, choose the Audio tab.
The window will look like this:

(e) Make note of the MIDI Music Playback default device.
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2.

Run the Windows Multimedia player, as follows:
(a) With the left mouse button, click the Start button in the lower, left corner of the screen. Move
the cursor to the "All Programs" listing.
Windows will display a menu.
(b) In the menu, choose Accessories.
(c) In the Accessories submenu, choose Entertainment.
(d) In the Entertainment submenu, choose Windows Media Player.
This will start the Windows Media Player program.

3.

In the Windows Media Player, play the Minuet.mid MIDI file that is installed with N o ta tio n
P la y e r:
(a) In the File menu of the Windows Media Player, choose the Open command.
(b) In the File Open dialog box, navigate to this directory, if it is not already opened as the
default directory:
c:\Program Files\Notation\Songs

(c) Double-click the file name Minuet.mid.
4.

Play the MIDI file by pressing the play control in the Windows Media Player, or by choosing
the Play command in the Play menu.

5.

If you do not hear sound from Windows Media Player, then repeat the following steps until you
find an available MIDI device by which you can hear sound in the Windows Media Player:
(a) Exit the Windows Media Player.
(b) Repeat all of the steps in this procedure, starting at step #1, except as noted next.
(c) After step 1(d), select another available MIDI playback device.

4.9

6.

Once you have found a MIDI device that works with the Windows Media Player, select that
device in the Quick MIDI Device Setup.

7.

If you do not find a MIDI device that works with the Windows Media Player, then there may be a
problem with the installation of the soundcard and/or its drivers on your system. Try reinstalling your soundcard driver, or downloading and installing the latest version of its driver
from the web site of the manufacturer of your soundacard.

Reassigning MIDI Devices
Most MIDI files and Notation (.not) files play back to a single MIDI device. Normally, this will be the
MIDI device that you specify with the Quick MIDI Device Setup command.
Some Notation (.not) files assign more than one MIDI device to the tracks. The Notation file stores for
each track the name of the device the track is assigned to. If your system happens to have the same
MIDI devices as those used by the author of the Notation file, and if the author has not renamed the
devices, then N o ta tio n P la y e r will automatically assign the tracks to the same MIDI devices on your
system as those intended by the author of the Notation file.
If the Notation file has tracks assigned to more than one MIDI device, and the devices do not have the
same name as those on your system, then N o ta tio n P la y e r will need your help in reassigning the
devices. If you do not hear all of the tracks (instruments) during playback, one possible reason is that
the tracks were assigned to devices that are not present on your system. You can easily fix this
problem using the Reassign MIDI Devices command in the Perform menu.
T o re a s s ig n MID I d e v ic e s to tra c k s in the N o ta tio n (.no t) file :
Choose the Reassign MIDI Devices command in the Perform menu.

Playing Songs

45

N o ta tio n P la y e r will present a dialog box such as shown below:

The MIDI devices listed in the left column are those that were assigned to tracks by the author
of the Notation (.not) file. The list of devices in the right column will be initially blank.
For device listed in the list column, select a MIDI device that is present on your system. Click
the mouse in the right cell. N o ta tio n P la y e r will present a list of MIDI devices available on
your system.
Click the OK button to finalize the MIDI device reassignments.
Play the song to confirm that all of the tracks (instruments) are heard. If not, then try assigning
different MIDI devices.
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Formatting the Score
N o ta tio n P la y e r offers options listed below for formatting the score:
Show or Hide Instrument Names
Hide Empty Staves
Measure Numbers
The above options serve the most common needs for reviewing scores quickly. For advanced
formatting options, such as inserting page breaks and system breaks, or changing the font size of
individual music symbols or text, you will need N o ta tio n Mus ic ia n or N o ta tio n Co mp o s e r.
A Notation (.not) file may have been carefully prepared by the author with special formatting. In this
case, it is generally advised that you do not edit the Notation file, unless you have a good reason.
Otherwise, the formatting prepared by the author will be disrupted. N o ta tio n P la y e r does not offer the
tools that N o ta tio n Mus ic ia n or N o ta tio n Co mp o s e r do for re-formatting the score.
A Notation (.not) file may include multiple instrumental or vocal parts for a small or large ensemble.
You can select each part in N o ta tio n P la y e r and see it, exactly as originally prepared by the
Notation file author.

5.1

Selecting a Part
Use the Parts List in N o ta tio n P la y e r's menu to select the part you wish to view.
If a MIDI (.mid) or Karaoke (.kar) file has multiple tracks, then the Parts List will have one entry for "All
Parts", plus one entry for each track in the file. You can view all of the parts at once, or any one of them.
(In N o ta tio n Mus ic ia n a nd Co mp o s e r you can view any combination of parts at one time.)
A Notation (.not) file may include separately formatted parts prepared by the author using N o ta tio n
Mus ic ia n or Co mp o s e r. A part typically displays the notes performed by one musician in a small
ensemble, or by musicians playing a like instrument in a large ensemble. A good way to think about
N o ta tio n's definition of a part is to visualize the printed music that one member of an ensemble reads
during a performance. If a Notation file has been prepared with parts, then you can select any part to
view and play.
T o s e le c t a p a rt:

5.2

1.

Click the dropdown arrow at the right of the Parts List in N o ta tio n P la y e r's menu:

2.

Click on one of the parts.

Showing or Hiding Instrument Names
When you open a MIDI file, N o ta tio n P la y e r will, by default, display the track names as instrument
names along the left side of staves:
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If you open a Notation (.not ) file, the instrument names may or may not be visible, depending on how
the author of the file saved them using N o ta tio n Mus ic ia n or Co mp o s e r.
T o s ho w o r hid e ins trume nt na me s :
Toggle the checkmark for S ho w o r H id e Ins trume nt N a me s in the S c o re menu.

5.3

Hiding Empty Staves
In a conductor's score, it is common practice to present staves only for those instruments that are
playing. For example, if a system in the score displays measures 10 through 14, and the flutes are not
playing in these measures, then the conductor's part omits the flute staff in this system.
N o ta tio n P la y e r offers an option to hide empty staves, according to this common practice for a
conductor's part. If a staff has lyrics, but no notes, N o ta tio n P la y e r will still display the staff. If no
staves in a system have notes or lyrics, then N o ta tio n P la y e r displays only the first staff.
T o hid e e mp ty s ta v e s :
In the S c o re menu choose the H id e E mp ty S ta v e s command.

5.4

Measure Numbers
N o ta tio n P la y e r offers several options for displaying measure numbers, such as at every 5th
measure, or at the first measure of every system.
If a large musical work is divided into more than one MIDI file, then you might want the measure number
of the second file to follow the last measure number of the previous file. You can do this as described
below.
T o c ho o s e a me a s ure numb e ring o p tio n:
1.

In the Score menu choose the Measure Numbers command.
N o ta tio n P la y e r will display the Measure Numbers dialog:
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2.

Choose one of the options in the dialog, and click OK.

All of the options are self-explanatory except perhaps for the first one: "first measure of every system".
A system is one line of measures on a page. The line of measures includes the staves for all of the
instruments or voices that are playing. Thus, this option displays a measure number at the first
measure of each line (system) on each page of the score.
T o s p e c ify s o me s ta rting me a s ure numb e r, o the r tha n 1, fo r the c o ntinua tio n o f a s o ng
in a s e c o nd MID I file :
Follow the same procedure as above. Enter the starting measure of the second .not file in
the "First measure number" field of the Measure Numbers dialog box.

Editing and Saving Songs
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Editing and Saving Songs
N o ta tio n P la y e r offers various options for formatting and editing the score. The options for formatting
the score are described in a separate section in this Users Guide.
N o ta tio n P la y e r enables editing only of a few important elements of the score. N o ta tio n P la y e r's
main purpose is to display and play the sheet music for a MIDI or Karaoke file, or of a Notation (.not)
file previously authored by a user of N o ta tio n Mus ic ia n or Co mp o s e r.
N o ta tio n P la y e r especially enables the editing of key signatures and clefs because these music
symbols are typically missing in MIDI files, and N o ta tio n P la y e r cannot always guess correctly what
they should be. N o ta tio n P la y e r gives you a chance to correct mistakes it might make in
determining key signatures and clefs.
N o ta tio n P la y e r might also make some mistakes in determining the accidentals (enharmonic
spelling) of notes, such as C# versus Db. Usually, the scores are quite readable even if a few such
spelling mistakes are made. If you find that you need to correct the note spellings, then you should
consider using N o ta tio n Mus ic ia n or N o ta tio n Co mp o s e r.
The topics that follow describe how to:

Add Key Signatures
Add Clefs
Collapse Multiple Measure Rests
Reverse (Undo) Commands

6.1

Adding Key Signatures
You can add key signature changes at the beginning of any measure of any staff in the score.
In transcribing a MIDI file, N o ta tio n P la y e r examines whether the file includes key signatures. If it
does, then N o ta tio n P la y e r uses the key signatures saved in the file. Otherwise, N o ta tio n P la y e r
analyzes the harmony of the song to determine the key signature. This analysis does not account for
possible mid-song key signature changes. N o ta tio n P la y e r determines a single key signature for
the whole song.
If you open a Notation (.not ) file, you may find that some parts have been transposed according to the
key of the instrument, such as a B-flat clarinet. If you want parts displayed in concert pitch rather than
transposed pitch, then you should use the Select Part command in the Score menu to find out whether
the author of the Notation file had saved an extra conductor score in concert pitch; if so, then select the
concert pitch score.
You should not attempt to convert transposed instrument parts to concert pitch parts by changing the
key signature. Changing the key signature will not transpose (or remove the transposition of) notes.
Rather, changing the key signature only adds or removes sharps or flats in front of notes.
T o ins e rt a k e y s ig na ture :
1.

Choose the Add Key Signature command in the Edit menu.
The mouse cursor will turn into this shape:

2.

Click the mouse anywhere in the measure where you want the key signature to be added or
changed.
N o ta tio n P la y e r will present you with the following dialog box:
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3.

Choose the key signature from the dialog box by using the up and down arrows to spin through
0 to 7 flats or sharps, or select the key signature by major or minor key name.

4.

If you wish the key signature change to be applied to all parts, rather than to just the part where
you clicked the mouse, then set a checkmark for "Apply key signature to all parts".

5.

Add or remove a checkmark in the last box, according to whether you want the new key
signature to be preceded with natural accidentals for each accidental removed in the new key
signature. For example, if the previous measure has a key signature of four sharps, and the
new key signature is two sharps, then this option produces the following key signature with two
cancelation natural accidentals:

6.

Click the OK to complete the change.
N o ta tio n P la y e r will apply the new key signature from your selected measure up to the next
measure where there is a different key signature, or to the end of the song if there are no other
key signature changes.

T o c ha ng e a k e y s ig na ture :
Follow the same instructions as above, adding the new key signature "on top" of the old one.
T o re mo v e a k e y s ig na ture :
Follow the same instructions as above, choosing a key signature that is the same as the other
key signature immediately preceding the key signature which you wish to remove.

Editing and Saving Songs

6.2

51

Adding Clefs
You can add clef changes at the beginning or middle of any measure of any staff in the score.
Clef information is not stored in MIDI files. Therefore, in transcribing a MIDI file, N o ta tio n P la y e r
guesses what the clefs should be based on a number of factors. Usually N o ta tio n P la y e r makes
good guesses, but these guesses will not always be correct. You can correct the clefs by following the
procedure below.
T o ins e rt a c le f:
1.

Choose the Add Clef command in the Edit menu.
The mouse cursor will turn into this shape:

2.

Click the mouse anywhere in the measure where you want the clef to be added or changed.
N o ta tio n P la y e r will present you with the following dialog box:

3.

Choose the clef from the dialog box by using the up and down arrows to spin through the
various choices.

4.

Click the OK to complete the change.
N o ta tio n P la y e r will apply the clef from its location up to the next measure where there is a
different clef.

T o c ha ng e a c le f:
Follow the same instructions as above, adding the new clef "on top" of the old one.
T o re mo v e a c le f:
Follow the same instructions as above, choosing a clef that is the same as the other clef
immediately preceding the clef which you wish to remove.

6.3

Collapsing Multiple Measure Rests
Throughout a score, wherever there are two or more measures with only rests for all of the staves, you
can specify whether each measure will be displayed with a whole measure rest, or whether all
measures are collapsed into a multiple measure rest. The following is an example of a two-measure
rest:

T o d is p la y multip le me a s ure re s ts :
In the Score menu, turn on the checkmark for Collapse Multiple Measure Rests.
T o d is p la y e a c h me a s ure with its o wn who le me a s ure re s t:
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Turn off the checkmark for Collapse Multiple Measure Rests in the Score menu.

6.4

Multiple Level Undo
N o ta tio n P la y e r supports multiple level undo. For example, if you change the font size, then add a
clef in some staff, and then use the Hide Empty Staves command, you can undo all of these editing
operations, called transactions, one by one in reverse order. Further, you can undo several
transactions at once. Also, once you have undone a transaction, you can change your mind and redo
it again.
Note that if you make some change to the score after undoing a transaction, then the undo of that
transaction is committed. That is, you can no longer redo that undone transaction.
N o ta tio n P la y e r's multiple level undo feature requires the allocation of additional memory for each
transaction that is saved. Eventually, if little memory is available on your system, N o ta tio n P la y e r will
display the following message in the status bar:

When you see this message, you should use the Clear Undo History command in the Edit menu. If you
need to undo any recent editing operations, you should undo them first before using the Clear Undo
History command. After you use the Clear Undo History command, the "memory is low" message will
usually go away. If the message is still displayed, then you may need to exit other programs that are
running at the same time as N o ta tio n P la y e r. If that does not work, then save your work with the Save
or Save As command in the File menu; exit N o ta tio n P la y e r; then run N o ta tio n P la y e r again and
reopen the file.
T o und o o ne o r mo re o f the mo s t re c e nt e d iting o p e ra tio ns (tra ns a c tio ns ):
1.

Click the Edit menu in the main menu bar. Beneath the Edit menu label, a command name for
undoing the most recent transactions will be listed, such as "Undo Set Key Signature." The
undo command for the first most recent transaction will be listed first; the undo command for
next most recent transaction will be listed second; and so on.

2.

Click the first Undo transaction command listed to undo the most recent transaction.
-- OR -Click some other Undo transaction command further down the list. All of the transactions from
that point through the most recent will be undone.
-- OR -Type CTRL+Z. This is a standard keystroke combination for the Undo command in most
Windows software applications.

After you undo one or more transactions, the next time you view the Edit menu, it will display Redo
transaction names for each of the most recently undone transactions.
T o re d o o ne o r mo re o f the mo s t re c e nt und o ne o p e ra tio ns (tra ns a c tio ns ):
1.

Click the Edit menu in the main menu bar. Beneath the Edit menu label, review the list of Redo
command names, such as "Redo Set Clef".

2.

Click the first Redo transaction command listed to redo the most recently undone transaction.
-- OR -Click some other Redo transaction command further down the list. All of the transactions from
the first up to the one you clicked will be redone.
-- OR --
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Type CTRL+Y. This a standard keystroke combination for the Redo command in most
Windows software applications.
T o fre e me mo ry us e d to s up p o rt the und o o f tra ns a c tio ns :
1.

Make sure that you do not want to undo any previous transactions, because once you follow
this procedure, you will no longer be able to undo them.

2.

Choose the Clear Undo History command in the Edit menu.
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About Notation Musician and Composer
If you are enjoying the free N o ta tio n P la y e r, then you might enjoy also using one of the other music
software programs in Notation Software's N o ta tio n product line, as summarized below. For a detailed
comparison of features in the four N o ta tio n products, see Comparison of Notation Products.

Who It's For Notation
Product
Mus ic Lo v e rs

What It's For

Watch the notes as they play your favorite
music.
View and play Notation (.not) files saved by any
N o ta tio n program.

Mus ic
H o b b y is ts
Ins trume nt
E ns e mb le
Me mb e rs

Have more fun listening to music.
Practice singing or playing your instrument.
Save money on sheet music.
Learn music notation.

Cho ir
Me mb e rs

For more details, see About Notation Musician

Mus ic
S tud e nts
(V o ic e a nd
Ins trume nt)

Enjoy a truly musician-friendly user interface.

Mus ic a l
P a re nts o f
S tud e nts

Practice music.

Mus ic
T e a c he rs
Ins trume nt
E ns e mb le
D ire c to rs
Cho ir
D ire c to rs
S e miP ro fe s s io na l
a nd
P ro fe s s io na l
Mus ic ia ns
S o ng -W rite rs

or visit our website to learn more about
N o ta tio n Mus ic ia n.

Arrange music for your own playing or singing.
Arrange music for your child or music student.

Prepare parts for your band or choir.
Compose and record your own songs and
music.
Prepare music that not only look s good but also
sounds great
For more details, see About Notation Composer
or visit our website to learn more about
N o ta tio n Co mp o s e r.
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About Notation Musician

N o ta tio n Mus ic ia n is the first member in the N o ta tio n product line above the free N o ta tio n P la y e r
version. N o ta tio n Mus ic ia n adds to N o ta tio n P la y e r many features that offer more musical
enjoyment, educational value, and practical uses.
The primary purposes of N o ta tio n Mus ic ia n are summarized below. For a tabular comparison of
features in N o ta tio n Mus ic ia n and N o ta tio n P la y e r, see Comparison of Notation Products.
indicates a feature or purpose shared by both N o ta tio n Mus ic ia n and
N o ta tio n P la y e r
indicates a feature or purpose included in N o ta tio n Mus ic ia n but not
N o ta tio n P la y e r

Have more fun listening to music
Download any of 100,000s of MIDI files on the Internet. N o ta tio n Mus ic ia n converts MIDI files
to sheet music with amazing accuracy.
Watch the notes on the screen as they play. Hear and see the score as a conductor does.
Slow down the tempo for closer listening.

Increase the volume for a selected instrument so that you can focus your listening on that
instrument.
Improve your listening skills, and enhance your enjoyment of music with an exciting new visual
dimension: the music notation.

Practice singing or playing your instrument
Play along with your acoustic instrument, or sing along, as you read the notes from your part
from the screen.
Let N o ta tio n Mus ic ia n play the accompaniment for other instruments.
Transpose the music for your instrument or voice range.
Slow down the tempo when you are first learning the music.
Let N o ta tio n automatically turn pages for you.
Set up practice loops for any range of measures, for any number of repeats, with optionally
increasing tempo.

Save money on sheet music
Convert to sheet music any of 100,000s of MIDI files on the Internet.
Correct errors that N o ta tio n might make transcribing the MIDI file to sheet music, such as
enharmonic spelling errors (eg, C# versus Db).
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Add a wide variety of music annotations, such as: accent marks, dynamic marks, hairpin
crescendos, slurs (phrase marks), sustain pedal marks, 8va (octave) marks, such as shown
below:

Editng the beaming of notes.
Convert written-out graces, trills and tremolos to notated ornaments, such as illustrated below:

Annotate the score with free text, such as for tempo marks:

Add page titles, headers, and footers.

For the v o ic e , easily merge lyrics and the melody, or add and edit lyrics.

For the p ia no , split a MIDI keyboard track into right- and left-hand staves. With a single
command, prepare a piano reduction of a instrumental or choir score.
For the g uita r, a uto ha rp , and p ia no , rearrange the score into a "fake book" with chord
names, Mus ic ia n analyzes the harmony of the music and displays chord names, such as C7
and Gm9.
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For d rums , split General MIDI (GM) drum tracks into a separate 1-line staff per each distinct
drum instrument. Assign drum symbols to noteheads:

For a wind or b ra s s instrument, transpose according to the key of the instrument. View and
print the conductor's score in concert pitch or transposed instrument pitches.
Control the format and pagination of the score, such as the location of page breaks and
system breaks.

Learn music notation
Learn to read music notation by seeing the notes as they play for songs you are familiar with. It
is like learning a foreign language by having someone point to things and saying their names
You will soon start associating in your mind the music notation that corresponds to notes that
you hear.
Slow down the tempo, even as little as one tenth of the normal playback speed, so that you
can better see and hear what notes are being played.
Prepare 'Easy Note' parts for student musicians, which look like this:

Refer to Mus ic ia n's User's Guide for explanations of more advanced music symbols.
Use Mus ic ia n as a tool to learn music notation as you are also studying music with a teacher
or friend.

Visit our website to learn more about N o ta tio n Mus ic ia n, see videos of Mus ic ia n in action, and
consider purchasing Mus ic ia n.

7.2

About Notation Composer

For even more musical fun, N o ta tio n Co mp o s e r offers all of the features of N o ta tio n P la y e r and
N o ta tio n Mus ic ia n, plus it allows you to rearrange music, refine the performance (MIDI), as well write
music from scratch.
The primary purposes of N o ta tio n Co mp o s e r are summarized below. For a tabular comparison of
features in N o ta tio n Co mp o s e r versus N o ta tio n P la y e r and N o ta tio n Mus ic ia n, see
Comparison of Notation Products. Be sure to review N o ta tio n Mus ic ia n' s fe a ture s , since all of
them are included in N o ta tio n Co mp o s e r.
indicates a feature or purpose shared by both N o ta tio n Co mp o s e r and
N o ta tio n Mus ic ia n
indicates a feature or purpose included in N o ta tio n Co mp o s e r but not
N o ta tio n Mus ic ia n
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Enjoy a truly musician-friendly user interface
Think like a musician, not like a computer expert, to intuitively do what you want.
Enjoy an elegant, un-cluttered user interface, which is optimized for learning as you go.

Arrange music for your own playing or singing
Find a music (MIDI) file on the Internet for the song or piece you want to play, and convert it to
sheet music.
Arrange the music to fit your performance skills.
Transpose the music for your instrument or voice range.
Add your own musical style to the arrangement. Add notes and change note pitches. Change
rhythms.
Prepare fake book lead sheets for the guitar or keyboard.

Arrange music for your child or music student
Find a music (MIDI) file on the Internet for the song or piece for your child or your music student,
and convert it to sheet music.
Arrange the music to fit your child's or music student's performance skills. Remove notes from
a more complicated arrangement.
Increase the font size for easier reading. For beginning students, display 'Easy Notes' with
pitch letters (e.g. C) inside the large notes.

Add free text annotation, such as tempo marks:

Practice music
Play along with your acoustic instrument, or sing along, as you read the notes from your part
from the screen.
Let Co mp o s e r play the accompaniment for other instruments
Slow down the tempo when you are first learning the music.
Let Co mp o s e r automatically turn pages for you.
Set up practice loops.
Control the starting, stopping, and rewinding of playback, and recording, remotely from you
MIDI keyboard.

Prepare parts for your band or choir
Quickly prepare the conductor's score starting from scratch, or by letting N o ta tio n accurately
transcribe a MIDI file for the piece.
Independently format and print each instrumental or vocal part, and yet the part is always
synchronized with the conductor's score. For example, add a note in the conductor' score, and
it will show up in the individual part, or vice versa.
Export audio files (.wav, .mp3, .flac, .ogg) for your members to listen to and follow along when
practicing on their own.

About Notation Musician and Composer
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Export MusicXML files that other members can import into other music notation programs to
work with.
At any time, toggle between concert pitches and instrument transpositions. The score or part is
correctly reformatted.
Aurally audit each part by muting other parts, or by temporarily increasing the volume level of
one part relative to others.

Compose and record your own songs and music
Start a new song, easily setting up the staves, meter, and key signature using the New Song
Wizard.
Add notes with the mouse, or record from a music (MIDI) keyboard in real time or step time.
Edit the notes with quick, easy, and intuitive methods. Co mp o s e r transcribes your MIDI
recording to notation with excellent accuracy.
Record multiple "takes" of a section and choose the one you like best using multiple-level
Undo and Redo.
Add a wide variety of music annotations, including accent marks, dynamic marks, ornaments
(grace notes, trills, tremolos, etc.), and slurs (phrase marks).

Add a variety of ornaments: grace notes, trills, tremolos, turns, mordents, arpeggios. Control
the exact performance of each note of the ornament: its attack, release, and loudness.
Move sections on a song from one location to another, or to another song, via the clipboard.

Prepare music that not only looks good but also sounds great
Refine the playback performance with the capabilities of a MIDI editing application, but with a
musical, notation-based user interface. Edit the exact timing of notes using piano notation that
is displayed on top of the notes:

Graphically view and edit the loudness of individual notes:

Graphically edit the song tempo, volume levels, pitch bends, and other MIDI data, by drawing
curves displayed on top of the notes:
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Insert instrument sound changes (MIDI program/patch events) anywhere within tracks.
Export audio files (.wav, .mp3, .flac, .ogg) for others to enjoy.
Configure your MIDI devices so that you can refer to MIDI banks, programs (patches) and
drum notes by names rather than by numbers. Insert MIDI program changes anywhere within
tracks.

Visit our website to learn more about N o ta tio n Co mp o s e r, see videos of Co mp o s e r in action,
and consider purchasing N o ta tio n Co mp o s e r.

7.3

Comparison of Notation Products
The following chart compares the purposes and features of the following three products in Notation
Software's N o ta tio n line: N o ta tio n P la y e r, Mus ic ia n and Co mp o s e r. For ordering and pricing
information for these two products, please visit our web site at www.notation.com.

Purpose and Features

Notation
Player

Notation
Musician

Notation
Compos
er

P urp o s e : Download MIDI files Internet and transcribe
them to sheet music that you can view on the screen as
the notes play.

Yes

Yes (and
print)

Yes (and
print)

About Notation Musician and Composer
Transcribe MIDI file to sheet music with excellent
accuracy, including detection of swing rhythms, grace
notes, trills and tremolos.

Yes

Yes

Yes

Correct any errors that might be made in the
transcription of the note rhythms.

No

Yes

Yes

Automatically analyze and display chord names.

No

Yes

Yes

P urp o s e : Enjoy and study the music notation a song
as it plays.

Yes

Yes

Yes

Highlight the notes and lyrics as they play.

Yes

Yes

Yes

Slow down the tempo so that you can hear the rhythms
more clearly.

No

Yes

Yes

Temporarily increase the volume of one track while
decreasing the volume of other tracks, so that you can
focus your listening on a particular instrument or voice.
"Solo" a track while the others are muted.

No

Yes

Yes

P urp o s e : Practice music as you sing along or play
your instrument with accompaniment

No

Yes

Yes

Transpose the pitch of a vocal part to match your voice
range.

No

Yes

Yes

Automatically turn pages.

Yes

Yes

Yes

Set up practice loops, to repeat a section of the song at
optionally increasing tempos.

No

Yes

Yes

Remotely execute commands from your keyboard,
such as Start Playback, End Playback, and Fast
Forward.

No

Yes

Yes

P urp o s e : Quickly prepare parts from a MIDI file, for use
by yourself or musicians in a performing group.

No

Yes

Yes

Prepare an "Easy Notes" part for student musicians,
showing note letters (for example "C") in the noteheads.

No

Yes

Yes

Prepare a "Sing-Along" vocal part, for easy sightreading from the screen while the song plays.

No

Yes

Yes

Prepare a fake book lead sheet part, with melody and
chords.

No

Yes

Yes

Prepare piano reduction of a score that has multiple
instruments or voices.

No

Yes

Yes
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Extract individual parts for the players or singers in your
music group.

No

Yes

Yes

Transpose an instrument's part to its natural key, such
as for a Bb clarinet,

No

Yes

Yes

Split a single piano/keyboard track into right- and lefthand staves.

No

Yes

Yes

Split a MIDI drum track into separate one-line drum
instrument staves.

No

Yes

Yes

Split a track into melody and accompaniment parts.

No

Yes

Yes

P urp o s e : Annotate the sheet music that has been
transcribed from a MIDI file.

No

Yes

Yes

Add lyrics.

No

Yes

Yes

Change enharmonic spellings of notes, such as C# to
Db.

No

Yes

Yes

Edit note beams.

No

Yes

Yes

No

Yes

Yes

Add accent marks and articulations, dynamic marks,
hairpin crescendo marks, slurs, pedal marks, and other
special music symbols.

No

Yes

Yes

Add staff symbols: brackets and braces, clefs, key
signatures, and barline types.

Clefs and
Key
Signatures

Yes

Yes

Add free text anywhere in the score.

No

Yes

Yes

Add rehearsal marks.

No

Yes

Yes

Add 8va octave marks.

No

Yes

Yes

Add repeat barlines and endings, which will be
interpreted during playback.

No

Yes

Yes

Add special repeat directives, such as "D.C.", for which
you can specify the destination measure.

No

Yes

Yes

P urp o s e : Format and print the score and parts.

No

Yes

Yes

Transcribe the following types of ornaments:
grace notes
trills
tremolos
Temporarily display an ornament as written-out notes,
or revert it to a written-out performance.
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Print an entire score, or an individual part.

No

Yes

Yes

Choose the default font size, face, and style for various
categories of music symbols and types of text. The
default can be overridden for specific items.

No

Yes

Yes

Specify the default horizontal spacing (degree of stretch
or compression) and default vertical spacing between
staves.

No

Yes

Yes

No

Yes

Yes

Add and control the placement of page title, footer and
header text.

No

Yes

Yes

Optionally hide empty staves.

Yes

Yes

Yes

Expand or collapse multiple-measure rests.

Yes

Yes

Yes

Format parts using templates.

No

Yes

Yes

Display one-line drum instrument staves using special
percussion noteheads.

No

Yes

Yes

P urp o s e : Re-arrange the notes of an existing song, or
create music from scratch.

No

No

Yes

Create a new song using a pre-defined template for a
variety of solo instruments, duet pairs, small
ensembles, and large ensembles. Or, use a custom
song template that you have previously prepared.

No

No

Yes

No

No

Yes

Control the layout of each page:
page breaks, system (line) breaks
number of measures on any given system,
number of systems on any given page
vertical spacing between any pair of staves
vertical spacing between adjacent systems
relative horizontal spacing of individual
measures within a system (line).

Add notes by whatever method is most convenient for
you:
with the mouse and computer keyboard.
using the Sequential Note Entry method,
whereby where you rarely have to select the
note duration, even when the sequence of
notes has different note duration.
using Step-Time recording, one note or chord
at a time, from your MIDI keyboard or input
device.
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Change pitches of notes.

No

No

Yes

Add tracks (instrument parts).

No

No

Yes

Add measures.

No

No

Yes

No

No

Yes

Change the meter and barline positions.

No

No

Yes

P urp o s e : Record music from your MIDI keyboard or
input device.

No

No

Yes

Your performance is transcribed using the same
excellent MIDI-to-notation transcription technology that
N o ta tio n uses to transcribe MIDI files to sheet music.

No

No

Yes

Set up the tempo for recording.

No

No

Yes

Set up the number of pick-up measures.

No

No

Yes

Record (punch in) into a selected region of a track.

No

No

Yes

Add (punch in) a recording of pitch bends or MIDI
controllers, on top of notes previously recorded.

No

No

Yes

P urp o s e : Edit the performance (MIDI) of the song.

No

No

Yes

N o ta tio n Co mp o s e r offers the features of a typical
MIDI sequencer program but in a more musically
oriented way. Editing of the music performance is highly
integrated with the music notation. N o ta tio n
Co mp o s e r offers an intuitive and fun way to refine the
details of the performance without requiring that you
know MIDI or work with tedious numbers.

No

No

Yes

Edit the exact as-performed rhythms of notes while
viewing Piano Roll Notation that is drawn on top of the
notes.

No

No

Yes

Edit the loudness of individual notes while viewing
"vectors" (lines drawn at an angle from each notehead)
that graphically show the loudness of each note.

No

No

Yes

Add ornaments:
graces notes
trills
turns
mordents
arpeggios
tremolos

About Notation Musician and Composer
Snap ("quantize") the as-perform attack or release of a
note to its notated rhythm.

No

No

Yes

Lock the as-performed rhythm of a note, as that you can
independently change its notated rhythm.

No

No

Yes

Edit the underlying performance of ornaments: grace
notes, trills, turns, tremolos, and arpeggios.

No

No

Yes

Graphically edit the song tempo.

No

No

Yes

Graphically edit the volume level, left-to-right pan,
pedal, and pitch bend activity in a track.

No

No

Yes

Graphically edit any MIDI controller data.

No

No

Yes

Edit MIDI data via event list view.

No

No

No

Edit System Exclusive (SysEx) events.

No

No

No

Edit keyswitch (KS) events, such as used by sound
libraries.

No

No

No
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8.1

Appendix A: What is MIDI?
MIDI (Musical Instrument Digital Interface) is an industry standard for passing musical performance
information among electronic musical instruments and computers. There are very few details about
MIDI that are necessary for you to understand in order to use N o ta tio n P la y e r. However, a general
understanding about MIDI will help you to more quickly understand how N o ta tio n P la y e r lets you
see as notation the music that you hear.
Most audio equipment that you are familiar with-- such as CD players and radios-- receive and send
sound in the form of sound waves, such as shown below.

In contrast, MIDI instruments receive and send music data as specific actions to be performed, such
as "play a Middle C note softly using the clarinet sound, for a duration of a quarter note at the current
tempo." The MIDI instrument receiving such an instruction then produces the sound wave such as the
one shown above.
When N o ta tio n P la y e r (or any MIDI program) records a musician's performance on a MIDI
keyboard, N o ta tio n P la y e r does not record the actual sound waves, such as shown above. Instead,
N o ta tio n P la y e r simply records what keys are played by the musician at what times, and with what
loudness.
The following diagram illustrates MIDI note performance data. Each rectangle represents a single
note that is to be performed using some instrument sound, such as a clarinet. The left edge of each
rectangle marks the starting time of the note, and the right edge marks the ending time of the note. The
vertical position of the rectangle represents the pitch of the note. This diagram does not illustrate the
additional MIDI information for the loudness of the note.

A diagram of a MIDI performance, such as shown above, is commonly called "Piano Roll Notation" in
music software programs that support the viewing and editing of MIDI. It is called Piano Roll Notation,
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because it looks quite similar to piano rolls that were used in mechanical player pianos that were
popular in the early 1900's. Each rectangle in the above diagram is like a hole in a piano roll. As the
piano roll is scrolled during the performance, the player piano plays a key on the piano when it detects
the hole, and releases the key when it detects the end of the hole.
Piano Roll Notation is an ideal way to visualize the performance of notes. N o ta tio n Co mp o s e r offers
you the option to see (and edit) both the Piano Roll Notation and standard music notation, at the same
time, as illustrated here:

For further information about Piano Roll Notation in N o ta tio n Co mp o s e r, see the topic About
Notation Composer or visit our website.
A MIDI file is a saved recording of a MIDI performance. For a given song, a MIDI file is much smaller
(as measured in bytes) than an equivalent audio recording of the song, saved in a .WAV or .MP3 file
format or CD audio format. This is because only a few numbers are needed in the MIDI format to
describe a note: its starting and ending times, pitch, loudness, and instrument sound. In contrast, tens
of thousands of numbers are needed to describe the audio sound waves for just one second of music.

8.2

Appendix B: Technical Support
1. U s e this U s e r' s Guid e (H e lp ).
This User's Guide provides detailed procedures for how to accomplish various tasks in N o ta tio n
P la y e r. We encourage you to give this User's Guide a try, since it is probably better organized,
more thorough, and easier to read than many user's guides that you have read.
In the left top corner of this window, choose the method of navigating through the User's Guide that
feels most natural for you: the Table Contents, the Index, or keyword Search.
2. V is it the N o ta tio n U s e rs Co mmunity Fo rum.
Notation Software offers the N o ta tio n U s e rs Co mmunity Fo rum, where N o ta tio n users trade
tips with each other and the developer, ask questions, report software bugs, and request new
features:
http://www.notation.com/vb-forum/index.php
3. R e fe r to the Fre q ue ntly A s k e d Que s tio ns a t N o ta tio n S o ftwa re ' s we b s ite .
Review our most frequently asked questions at:
http://www.notation.com/FAQs.php.
4. S e nd q ue s tio n to N o ta tio n S o ftwa re us ing the o nline fo rm, o r s e nd v ia e -ma il
If after exploring the above options your question still remains unanswered, then visit our Support
Desk.
Or, send your question via e-mail to: support@notation.com.
We will attempt to respond to you as quickly as possible.

8.3

Appendix C: Notation Player License Agreement
IMPORTANT:

Read carefully before clicking ‘I Agree’
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License Agreement
By clicking ‘I Agree’ before installing the program from Notation Software Germany GmbH, you are consenting
to be bound by this agreement. If you do not agree to all terms of this agreement, click the ‘I Do Not Agree’
button and Cancel. The installation process will terminate.

Notation Player License Agreement
In this document the term “Software” is defined as the Notation Player software program and all language
variants. By installing or otherwise using this Software, you agree to be bound by the terms of this License
Agreement. If you do not agree to the terms of this License Agreement, you must immediately terminate your
use of this Software and you must delete it completely from your computer system (including any backup
storage device).

1. Grant of License and Term
The Software is licensed, not transferred or sold, to you by Notation Software Germany GmbH (the term
“Notation Software” further used in this document stands for Notation Software Germany GmbH.) or it’s
licensed marketing agents, and is protected by German copyright and intellectual property laws, and the laws
of other countries under international treaty. This license agreement remains effective for any potential legal
successor of Notation Software Germany GmbH.
The License terminates automatically if you fail to comply with the limitations described herein. On termination,
you must destroy any copy (including archived backups) of the Software and its documentation.
Notation Software grants you a license to use the Software for as long as you want to use the Software. The
installation package contains open source software libraries in the form of Dynamic Link Libraries (DLL
libraries) and a soundfont file. The LGPL license applies to these libraries and to the soundfont file.
This license does not grant you the use of other software products sold by Notation Software.

2. Redistribution
You may redistribute exact copies of the Notation Player installation program to anyone in its unmodified form
via electronic means (Internet, bulletin boards, shareware distribution libraries, CD-ROMs, etc.). Any bundling
of the installation package with monetizing or advertising software is prohibited and will be prosecuted by
applicable laws. Anyone who so receives and installs the Software that has been redistributed from you will be
subject to the same terms and conditions of this License Agreement. You may not charge any fee for the
software copy, use or distribution of the Software.

3. Restrictions
You may not reverse engineer, decompile, or disassemble the Software, except and only to the extent that such
activity is expressly permitted by applicable law, notwithstanding this limitation. You must not alter the Software
for any purpose, including changing the display of the Notation Player name and Notation Software’s name.

4. No Liability
To the maximum extent permitted by applicable law, Notation Software is not liable for any indirect, special,
incidental, or consequential damages, including, but not limited to damages for loss of business, loss of
revenue or profit, lost or damaged data or other commercial or economic loss, which arise out of your use or
inability for incidental or consequential damages, so the above limitation or exclusion may not apply to you.
In addition Notation Software is not liable when copyrighted music sheets may be illegally handled.

5. General
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When you present or review the Software on a website you must clearly represent to the visitor that Notation
Software is the publisher of the Software. A link to Notation Software's website www.notation.com shall be in
place.
This Agreement represents the complete agreement concerning this license, and may not be changed except
by a signed amendment. If any provision of this Agreement is held to be unenforceable, such provision shall be
reformed only to the extent necessary to make it enforceable, and the other provisions shall remain in full force
and effect. This agreement shall be governed by the law of the Federal Republic of Germany.
We reserve the right to display advertising on the opening portal of the software.
Sincerely Yours,

Notation Software Germany GmbH
Eduard-Thoeny-Str. 6
D-86919 Utting am Ammersee
Germany
Amtsgericht Augsburg, Germany HRB 27100
USt-IdNr.: DE283550976

8.4

Appendix D: Licensing and Acknowledgements
Library

License

Prof-UIS

purchased license from Foss Software, Inc

QTHM

purchased license from GipsySoft

Ultimate Grid

Code Project Open License (CPOL) 1.02

TinyXML

zlib/libpng License

Haru PDF

zlib/libpng License

libfluidsynth(-pl).dll

LGPL v2.1 or later

glib

LGPL v2.1 or later

portaudio.dll

MIT license

libsndfile.dll

LGPL v2.1 or later

libglib-2.0-0.dll

LGPL v2.1 or later

libgthread-2.0-0.dll

LGPL v2.1 or later

lame_enc.dll

LGPL v2.1 or later (www.mp3dev.org)
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libogg.dll

BSD-Style Source License

libvorbis.dll

BSD-Style Source License

libFLAC.dll

LGPL v2.1 or later

Smtp

special license agreement by PJ Naughter (www.naughter.com)

contains QHTM code

QHTM is copyright (c) 1999 Russ Freeman

For Linux and Mac Notation Software uses the concept of WineHQ (www.winehq.org),
in particular for Mac we use the Wine package built by Mike Kronenberg
(http://winebottler.kronenberg.org/).

The libs with the LGPL license are built according to the license agreement in
separate dll files. In that set-up they are available for distribution in commercial
applications like Notation Software products. The source code can be downloaded
from the according distributor. All libs are built using the instructions of the distributor.

ASIO is a registered trademark of Steinberg Media Technologies GmbH
(www.steinberg.net)

Steinberg ASIO SDL Licensing Agreement signed between Notation
Software Germany and Steinberg Media Technologies GmbH on Dec. 3rd,
2018
Soundfont

License

TimGM6mb.sf2

LGPL v2.1 or later

FluidR3Mono_GM. agreement with owners, license included in the package
sf3
MusicXML

MusicXML Public License 3.0

The Band-in-a-Box® plugin for notation composer is licensed from PG Music, Inc.
(www.pgmusic.com).
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55
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ignoring endings during playback
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55
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55
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55
transcribing
55
clefs
adding
51
close
MIDI Karaoke or NoteSoft file
9
context-sensitive help (F1)
for buttons
5
Control Panel (Windows)
39
copyright
14
crescendo
hairpin crescendo marks
55

F1 help
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30
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32
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55
formatting
55
hide empty staves
47
measure numbers
47
move measure to previous system
55
move system to previous page
55
page breaks and system breaks
55
page layout
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-Ddevice
quick setup
7
trouble-shooting
40
directory (program folder) for MidiNotate
7
documentation
printing
6
using this
5
drum
55
editing of notes
55
split drum track into single drum staves
55
dynamic marks
55
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35
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35
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35
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36
grace notes
converting short notes to
55
transcription of 23
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55
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55
help
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hide
parts of the MidiNotate window

-Iinstalling MidiNotate Player
instrument
names
46

6

-Jjamming along with a song

55

28

Index
opening

-KKaraoke file
.kar file name association with MidiNotate
closing
9
opening
14
key signature
adding
49
keyboard (MIDI)
7

9

-O19

-Llicense agreement
67
loops
practice
55
lyrics
adding and editing
55
lyricist
14

octaves
8va
55
opening a MIDI or Karaoke file
automatically launching MidiNotate Player
19
viewing multiple songs at a time
32
opening a song file
opening a MIDI Karakoe or NoteSoft file
9
ornaments
55
grace notes
55
transcription of 23
tremelos
55
trills
55
overlapping notes
transcription option to remove
23

-P-

-Mmanual
6
in Adobe Acrobat PDF file format
6
in Microsoft Word DOC format
6
measure
go to a
35
numbers
47
menus
29
Microsoft Word DOC printable documentation
MIDI described
66
MIDI file
.mid file name association with MidiNotate
closing
9
opening
14
MIDI keyboard
7
MidiNotate (.not) file
open
14
MidiNotate product line
MidiNotate Musician
55
MP3
compared to MIDI 66
multiple measure rests
51
Musician (MidiNotate)
55

-Nnext page
35
notes
55
Easy Note notation
enharmonic spelling
NoteSoft (.not) file
9
closing
9
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55

6

19

page number
go to
35
page text
55
page view
31
part
select
46
PDF printable version of documentation
6
pedal marks
55
phrase marks
55
piano part
55
reduction of score
55
split single track into right- and left-hand staves
55
playback
11
changing position during playback
39
fast forward
39
green position marker
11
ignoring repeats and endings during
40
indicator in quick MIDI setup window
37
playback position marker
39
start and stop
38
stuck notes
39
toolbar button
30
trouble-shooting
40
tutorial
11
point size
versus zoom
34
practicing options
55
loops (repeats)
55
overview
55
previous page
35
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print preview
31
printing this documentation
6
program folder (directory) for MidiNotate

7

-Qquick MIDI device setup

37

-Rrehearsal marks
go to
36
repeats
ignoring repeats during playback
resize window
33
rests
multiple measure rests
51
transcription option
23
rewind
30
rhythm
rhythm style used in transcription

40

23

-Ssetup
MidiNotate
6
uninstalling
8
sheet music
saving money on
55
slurs
55
song
14
copyright notice
14
title
14
viewing multiple songs at a time
sound
no sound heard
40
sound module
7
soundcard (see device)
7
spelling (enharmonic)
55
staff
hide empty staves
47
start playback
38
stop playback
30
stuck notes
turning off 39
support
67
swing rhythm
transcription
23
synthesizer
7

-Ttechnical support

67

32

tempo
55
changing during playback
55
slowing down
55
ties
reducing number of 23
title of song
page title
55
toolbar
play and record buttons
30
volume control
31
zoom in and zoom out
31
track
part preparation
46
transcription
23
correcting errors
55
options
23
ornaments
23
re-transcribing
25
rhythm style
23
why it might look wrong
25
transpose
55
as-heard pitches
55
instrument key transposition
55
tremolos
converting written-out tremolos to notated
55
transcription of 23
trills
converting written-out trills to notated
55
transcription of 23
trouble-shooting
playback
40

-Uundo

52

-Vvoice
transcription option
23
volume level
55
changing for a single track
55
changing volume during playback
toolbar button
31

55

-WWAV file format
compared to MIDI 66
window
resize
33
showing and hiding parts of the window

28

Index
window view
31
Word DOC printable version of documentation

-Zzoom
34
changing zoom level
34
toolbar buttons
31
versus point size
34

6
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